Mac OS X Server
QuickTime Streaming Server 5.5
Administration
For Version 10.4 or Later
# Contents

## Preface
7  **About This Guide**
7  What's New in QuickTime Streaming Server (QTSS) for Mac OS X Server Version 10.4
9  The QuickTime Suite of Products
10  What's in This Guide
10  Using Onscreen Help
11  The Mac OS X Server Suite
12  Getting Documentation Updates
13  For More Information

## Chapter 1
15  **Overview of QuickTime Streaming**
15  What Is Streaming?
16  Live Versus On-Demand Delivery
16  Progressive Download (HTTP) Delivery Versus Streaming (RTP/RTSP) Delivery
16  Instant-On Streaming
17  Simple Setup for Live Video
18  Ways to Receive Streamed Media
19  Multicast Versus Unicast
20  Relays

## Chapter 2
23  **Setting Up Your QuickTime Streaming Server**
23  Hardware and Software Requirements for QuickTime Streaming
23  Viewer Computer Requirements
23  Live Broadcasting Requirements
24  Bandwidth Considerations
24  Setting Up Your Streaming Server
25  Testing Your Setup
26  Accessing Media Streamed From Your Server

## Chapter 3
27  **Managing Your QuickTime Streaming Server**
28  Using the Web-Based Application to Manage QuickTime Streaming
29  Using Server Admin to Manage QuickTime Streaming
29  Starting or Stopping Streaming Service
29  Changing the Maximum Number of Stream Connections
29  Changing the Maximum Streaming Throughput
30  Changing the Streaming Media Directory
30  Binding the Streaming Server Admin Computer to an IP Address
30  Hosting Streams From Multiple User Media Directories
31  Setting Up Relay Streams
32  Changing QuickTime Streaming Log Settings
32  Reading QuickTime Streaming Logs
33  Security and Access
34  Serving Streams Past Firewalls Using Port 80
34  Streaming Past Firewalls or Networks With Address Translation
35  Changing the Password Required to Send an MP3 Broadcast Stream
35  Using Automatic Unicast (Announce) With QTSS on a Separate Computer
35  Advanced Management Tasks
39  Controlling Access to Streamed Media
39  Configuring a Multicast Relay

Chapter 4  Managing Your Media With QTSS Publisher
41  Overview of QTSS Publisher
42  About Playlists and Hinting
43  Connecting to Mac OS X Server
43  Uploading Media From QTSS Publisher to a QuickTime Streaming Server
43  Preparing Content for Web Delivery
43  Preparing Prerecorded Media for Streaming
44  Improving the Performance of Hinted Movies Exported From QuickTime Player
44  Choosing a Thumbnail for a Movie on a Webpage
45  Creating and Editing Movie Annotations
45  Specifying Where to Play Media on a Webpage
45  Creating and Managing Playlists
48  Delivering Your Content
48  Making Content Available for Streaming or Downloading
48  Specifying Which Server to Broadcast From
48  Creating Webpages

Chapter 5  Troubleshooting and Technical Information
51  Using Log Files to Monitor Playlist Broadcasts
51  Media Files Don't Stream Properly
52  Administrator Can't Use QTSS Publisher to Publish Media
52  Users Can't Connect to Your Broadcast
52  Users See Error Messages While Streaming Media
53  Users Want to Back Up Databases that QTSS Publisher Maintains

Chapter 6  Setup Example
57  Streaming Presentations—Live and On Demand
59  Setting It Up
Contents

66 Creating a Webpage for Easy Access
68 Shooting the Live Presentation
68 Archiving the Live Presentation

Glossary  71
Index  79
About This Guide

Learn about the QuickTime suite of products and what’s new in this version of QuickTime Streaming Server.

Mac OS X Server version 10.4 includes QuickTime Streaming Server (QTSS) version 5.5 in its suite of services. QTSS comes preinstalled on Apple server hardware.

QTSS is similar in design and configuration to Apache, the popular web server software that is also included in Mac OS X Server. If you have experience working with Apache, QTSS will seem familiar.

If you have previously administered a QuickTime Streaming Server using the web-based application, Web Admin, you can continue to do so. Web Admin is useful for administering a streaming server remotely or from non-Macintosh computers. (For more information, see “Using the Web-Based Application to Manage QuickTime Streaming” on page 28.) Server Admin for Mac OS X Server (starting with version 10.3) includes a user-friendly interface for accomplishing the tasks you performed with Web Admin.

What’s New in QuickTime Streaming Server (QTSS) for Mac OS X Server Version 10.4

Built in to Mac OS X Server version 10.4 is QuickTime Streaming Server 5.5, Apple’s industrial-strength, standards-based streaming server with improvements in standards support and overall reliability. QTSS 5.5 delivers a number of enhancements:

- **Increased support for streaming to mobile phones:** QTSS 5.5 includes a number of enhancements for streaming live and on-demand 3GPP (.3gp) files to a variety of mobile phones.

- **Support for streaming HD movies:** Performance of QTSS has been increased to support streaming of HD content. QTSS 5.5 can stream thousands of simultaneous movies encoded at 1280x720, 24p, 5mbps from a single Xserve G5. QTSS 5.5 now supports streaming of live and on-demand content encoded with the new AVC/H.264 codec, which is included with Quicktime 7.
• **H.264 streaming support**: QTSS 5.5 supports streaming of live and on-demand content encoded with the new H.264 video codec, which is included with QuickTime 7.

• **QTSS Publisher**: Included with Mac OS X Server v10.4 is the next generation of Apple’s content management software, QTSS Publisher. This version includes a number of enhancements making it even easier to use and automate:
  - **User interface**: QTSS Publisher now sports a brand new user interface making it even easier to manage your server-side media and prepare it for delivery over the Internet or mobile networks. For more information, see Chapter 4, “Managing Your Media With QTSS Publisher.”
  - **Home directory support**: Non-admin users of the server can now log in to QTSS Publisher and upload movies to their home directory for streaming. This allows server administrators to give users permission to upload media to the server without having to give them admin privileges as well as the ability to put quotas on disk space usage.
  - **AppleScript support**: Extend the functionality of QTSS Publisher as well as automate many of the tasks using AppleScript. Examples include, batch processing of media, automated publishing of playlists, automated creation of webpages, and much more.

Other features of QTSS include:

• **Native 3GPP**: Stream industry-standard 3GPP files to any compliant 3GPP player device.

• **Native MPEG-4 streaming**: Stream ISO-compliant, hinted MPEG-4 files to any ISO-compliant MPEG-4 player, or device.

• **MP3 audio streaming**: Create your own Internet radio station. You can serve standard MP3 files using Icecast-compatible protocols over HTTP. Build a playlist of MP3 files and serve them to MP3 clients such as iTunes, SoundJam, and WinAmp for a simulated live experience.

• **Skip protection**: Apple skip-protection technology—a collection of quality-of-service features—takes advantage of excess available bandwidth to buffer ahead data locally to the client.

• **Instant-On**: Viewers with a broadband connection watching a streaming video with QuickTime 6 and later will benefit from Instant-On, an advance that provides enhanced overbuffering of data, resulting in dramatically reduced buffer time. With Instant-On, broadband users can also “scrub” forward and back with the time slider through an on-demand media stream and have playback updated instantly.

• **Authentication**: Two types of authentication, digest and basic, let you control access to protected media.
• **Server-side playlists:** You can stream a set of media files as if it were a live broadcast. This can be ideal for creating and managing a virtual radio or television station.

• **Relay support:** You can easily set up several layers of servers to broadcast streams to a virtually unlimited number of clients.

## The QuickTime Suite of Products

The QuickTime suite of products is unique in that it provides all the software you need to produce, transmit, and receive streamed media. Each product is designed from start to finish for optimum compatibility with all the other components in the suite.

The QuickTime suite comprises the following products:

- **QuickTime Player:** The free QuickTime Player is an easy-to-use application for playing, interacting with, or viewing any video, audio, virtual reality (VR), or graphics file that is compatible with QuickTime.

- **QuickTime Pro:** The powerful “pro” version of QuickTime Player provides an abundance of media authoring capabilities. You can capture audio and video, create slideshows, encode video and audio, edit movie tracks, create hint tracks, create media skins, and assemble hundreds of different media types into one movie file.

- **QuickTime Streaming Server:** Included with Mac OS X Server, QuickTime Streaming Server (QTSS) software enables you to deliver live and on-demand media in real time using the industry standard RTSP/RTP protocols over the Internet with no per-stream license fees. Users see streamed media as soon as it reaches the computer; they don’t have to wait to download files.

- **Darwin Streaming Server:** This free, open-source version of QuickTime Streaming Server supports popular enterprise platforms such as Linux, Windows Server 2003 and Solaris. It is available for download in source and can be compiled on a variety of platforms by modifying a few platform-specific source files.

- **QuickTime Broadcaster:** With QuickTime Broadcaster, you can produce a live broadcast event that anyone with an Internet connection can "attend" in real time. Combining the power of QuickTime with legendary Apple ease of use, QuickTime Broadcaster is included with Mac OS X Server (and is also available as a free download from the Apple website). QuickTime Broadcaster supports most codecs supported by QuickTime.
What’s in This Guide
This guide includes the following chapters:
• Chapter 1, “Overview of QuickTime Streaming,” explains streaming concepts and terms.
• Chapter 2, “Setting Up Your QuickTime Streaming Server,” lists hardware and software requirements, and provides instructions for setting up and testing your streaming server.
• Chapter 3, “Managing Your QuickTime Streaming Server,” provides step-by-step instructions for using the Server Admin application to administer and monitor a streaming server locally or remotely.
• Chapter 4, “Managing Your Media With QTSS Publisher,” provides information about using the QuickTime Streaming Server Publisher application to prepare, organize, and upload media for streaming.
• Chapter 5, “Troubleshooting and Technical Information,” describes common problems and provides information on what to do if you encounter problems while streaming media.
• Chapter 6, “Setup Example,” provides detailed information about the key components needed for a generic webcasting setup.
• The Glossary provides brief definitions of terms used in QuickTime Streaming and in this guide.

Note: Because Apple frequently releases new versions and updates to its software, images shown in this book may be different from what you see on your screen.

Using Onscreen Help
You can view instructions and other useful information from this and other documents in the server suite by using onscreen help.

On a computer running Mac OS X Server, you can access onscreen help for QuickTime Streaming after opening Workgroup Manager or Server Admin. From the Help menu, select one of the options:
• Workgroup Manager Help or Server Admin Help displays information about the application.
• Mac OS X Server Help displays the main server help page, from which you can search or browse for server information.
• Documentation takes you to www.apple.com/server/documentation, from which you can download server documentation.
• QTSS Publisher Help, available when QTSS Publisher is active, displays information about the application.
You can also access onscreen help from the Finder or other applications on a server or on an administrator computer. (An administrator computer is a Mac OS X computer with server administration software installed on it.) Use the Help menu to open Help Viewer, and then choose Library > Mac OS X Server Help.

To see the latest server help topics, make sure the server or administrator computer is connected to the Internet while you're using Help Viewer. Help Viewer automatically retrieves and caches the latest server help topics from the Internet. When not connected to the Internet, Help Viewer displays cached help topics.

The Mac OS X Server Suite
The Mac OS X Server documentation includes a suite of guides that explain the services and provide instructions for configuring, managing, and troubleshooting the services. All of the guides are available in PDF format from:

www.apple.com/server/documentation/

<table>
<thead>
<tr>
<th>This guide...</th>
<th>tells you how to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS X Server Getting Started for Version 10.4 or Later</td>
<td>Install Mac OS X Server and set it up for the first time.</td>
</tr>
<tr>
<td>Mac OS X Server Upgrading and Migrating to Version 10.4 or Later</td>
<td>Use data and service settings that are currently being used on earlier versions of the server.</td>
</tr>
<tr>
<td>Mac OS X Server User Management for Version 10.4 or Later</td>
<td>Create and manage users, groups, and computer lists. Set up managed preferences for Mac OS X clients.</td>
</tr>
<tr>
<td>Mac OS X Server File Services Administration for Version 10.4 or Later</td>
<td>Share selected server volumes or folders among server clients using these protocols: AFP, NFS, FTP, and SMB/CIFS.</td>
</tr>
<tr>
<td>Mac OS X Server Print Service Administration for Version 10.4 or Later</td>
<td>Host shared printers and manage their associated queues and print jobs.</td>
</tr>
<tr>
<td>Mac OS X Server System Image and Software Update Administration for Version 10.4 or Later</td>
<td>Use NetBoot and Network Install to create disk images from which Macintosh computers can start up over the network. Set up a software update server for updating client computers over the network.</td>
</tr>
<tr>
<td>Mac OS X Server Mail Service Administration for Version 10.4 or Later</td>
<td>Set up, configure, and administer mail services on the server.</td>
</tr>
<tr>
<td>Mac OS X Server Web Technologies Administration for Version 10.4 or Later</td>
<td>Set up and manage a web server, including WebDAV, WebMail, and web modules.</td>
</tr>
<tr>
<td>Mac OS X Server Network Services Administration for Version 10.4 or Later</td>
<td>Set up, configure, and administer DHCP, DNS, VPN, NTP, IP firewall, and NAT services on the server.</td>
</tr>
</tbody>
</table>
Getting Documentation Updates

Periodically, Apple posts new onscreen help topics, revised guides, and additional solution papers. The new help topics include updates to the latest guides.

- To view new onscreen help topics, make sure your server or administrator computer is connected to the Internet and click the Late-Breaking News link on the main Mac OS X Server help page.
- To download the latest guides and solution papers in PDF format, go to the Mac OS X Server documentation webpage: www.apple.com/server/documentation.

<table>
<thead>
<tr>
<th>This guide...</th>
<th>tells you how to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS X Server Open Directory Administration for Version 10.4 or Later</td>
<td>Manage directory and authentication services.</td>
</tr>
<tr>
<td>Mac OS X Server QuickTime Streaming Server Administration for Version 10.4 or Later</td>
<td>Set up and manage QuickTime streaming services.</td>
</tr>
<tr>
<td>Mac OS X Server Windows Services Administration for Version 10.4 or Later</td>
<td>Set up and manage services including PDC, BDC, file, and print for Windows computer users.</td>
</tr>
<tr>
<td>Mac OS X Server Migrating from Windows NT to Version 10.4 or Later</td>
<td>Move accounts, shared folders, and services from Windows NT servers to Mac OS X Server.</td>
</tr>
<tr>
<td>Mac OS X Server Java Application Server Administration for Version 10.4 or Later</td>
<td>Configure and administer a JBoss application server on Mac OS X Server.</td>
</tr>
<tr>
<td>Mac OS X Server Command-Line Administration for Version 10.4 or Later</td>
<td>Use commands and configuration files to perform server administration tasks in a UNIX command shell.</td>
</tr>
<tr>
<td>Mac OS X Server Collaboration Services Administration for Version 10.4 or Later</td>
<td>Set up and manage Weblog, iChat, and other services that facilitate interactions among users.</td>
</tr>
<tr>
<td>Mac OS X Server High Availability Administration for Version 10.4 or Later</td>
<td>Manage IP failover, link aggregation, load balancing, and other hardware and software configurations to ensure high availability of Mac OS X Server services.</td>
</tr>
<tr>
<td>Mac OS X Server Xgrid Administration for Version 10.4 or Later</td>
<td>Manage computational Xserve clusters using the Xgrid application.</td>
</tr>
<tr>
<td>Mac OS X Server Glossary: Includes terminology for Mac OS X Server, Xserve, Xserve RAID, and Xsan</td>
<td>Interpret terms used for server and storage products.</td>
</tr>
</tbody>
</table>
For More Information
For more information, consult these resources:

Read Me documents—important updates and special information. Look for them on the server discs.

Mac OS X Server website—gateway to extensive product and technology information. www.apple.com/macosx/server/

AppleCare Service & Support—access to hundreds of articles from Apple's support organization. www.apple.com/support/

Apple customer training—instructor-led and self-paced courses for honing your server administration skills. train.apple.com/

Apple discussion groups—a way to share questions, knowledge, and advice with other administrators. discussions.info.apple.com/

Apple mailing list directory—subscribe to mailing lists so you can communicate with other administrators using email. lists.apple.com/

The QuickTime Streaming Server products website—the latest information on key features, recent downloads, and minimum requirements, with links to additional support pages. www.apple.com/quicktime/products/qtss/

QuickTime for the Web—an excellent Apple QuickTime Developer Series book that explains how to integrate video, recorded sound, Flash animation, virtual reality, MIDI, text, still images, live streams, games, and user interactivity into a website. The companion CD-ROM includes QuickTime Pro and a full set of development tools for both Windows and Macintosh. Published by Morgan Kaufmann, this award-winning book is featured with other useful titles on the QuickTime instructional website. www.apple.com/quicktime/tools_tips/books.html

The QuickTime Services website—lists of streaming service providers. www.apple.com/quicktime/tools_tips/services/
Internet Engineering Task Force (IETF) website—Request for Comments (RFC) memorandums on the RTP and RTSP standards.
www.ietf.org/rfc/rfc1889.txt (RTP)
www.ietf.org/rfc/rfc2326.txt (RTSP)

The public source website—access to Darwin Streaming Server source code, developer information, and FAQs.
developer.apple.com/darwin/projects/streaming/
Overview of QuickTime Streaming

Before you set up your QuickTime Streaming Server, learn what streaming is all about.

What Is Streaming?
“Streaming” is the delivery of media, such as movies and live presentations, over a network in real time. A computer (a streaming server) sends the media to another computer (a client computer), which plays the media as it is delivered. With streaming, no files are downloaded to the viewer’s hard disk. You can stream media at various rates, from modem to broadband.

Just as you need a web server to host a website, to send streams over the Internet or a local network, you need a streaming server, which transmits video and audio streams on request. For small audiences, the same computer can run web server software, mail server software, and streaming server software. For larger audiences, one or more computers are typically dedicated as streaming servers.

When a user requests a stream (using client software such as QuickTime Player), the request is handled using Real-Time Streaming Protocol (RTSP). Streams are sent using Real-Time Transport Protocol (RTP). A streaming server can create streams from QuickTime movies stored on a disk, and can transmit live streams to which it has access.

With QuickTime Streaming Server (QTSS) software, you can deliver:
• Broadcasts of live events in real time
• Video on demand
• Playlists of prerecorded content
Live Versus On-Demand Delivery
Real-time streaming media is delivered in two ways: live and on demand. QuickTime Streaming Server delivers both.

Live events, such as concerts, speeches, and lectures, are commonly streamed over the Internet as they happen, using broadcasting software such as QuickTime Broadcaster. Broadcasting software encodes a live source, such as video from a camera, in real time and delivers the resulting stream to the server. The server then serves, or “reflects,” the live stream to clients. Regardless of when people connect to the stream, everyone sees the same point in the stream at the same time. You can simulate a live experience with recorded content by broadcasting from an archive source such as a tape deck or by creating playlists of media on the server.

With on-demand delivery, such as a movie or an archived lecture, each customer initiates the stream from the beginning, so no one comes in “late” to the stream. No broadcasting software is required for on-demand delivery.

Progressive Download (HTTP) Delivery Versus Streaming (RTP/RTSP) Delivery
Progressive download (sometimes called “Fast Start”) is a method of delivering a movie over the Internet so that it can start playing before its file is fully downloaded. With progressive download, a movie has all the data needed to start playing at the beginning of the file, so QuickTime can start to play the movie as soon as the first part of the file is transferred. Unlike streaming, where you can watch movies without downloading any files, Fast Start movies are actually downloaded to the viewer’s computer.

A Fast Start movie can be self-contained, so that all the data is stored inside the movie itself, or it can include pointers to data located on the Internet. You can watch progressive download movies in a web browser using the QuickTime plug-in or using QuickTime Player.

You can create progressive download movies for viewers with various connection speeds (called “reference movies”) and a streaming movie for viewers with the fastest connections.

Instant-On Streaming
Viewers watching a streaming video with QuickTime 6 and later will benefit from Instant-On, an advance in Apple skip-protection technology that dramatically reduces buffer, or wait, time for an instantaneous viewing experience. Viewers can click around or scrub video as if it were on their hard disks.

Users must have a broadband connection to experience Instant-On streaming. The responsiveness of Instant-On streaming is affected by available bandwidth and size, or data rate, of the content. Responsiveness can also be affected by the codec used.
Simple Setup for Live Video

The illustration below shows a setup for streaming live video and audio. (Most video cameras have a built-in microphone.) You can stream audio only using a microphone, mixer, and other appropriate audio equipment.

A PowerBook G4 with QuickTime Broadcaster software captures and encodes video and audio. The encoded signal is sent over an Internet Protocol (IP) network to a server computer running QuickTime Streaming Server (QTSS) software. QTSS on the server computer sends the signal over the Internet or a local network to client computers that request the stream using QuickTime Player.

You can also run QuickTime Broadcaster and QTSS on the same computer. If you are broadcasting to a large audience (more than, say, 100), however, Apple recommends that you run QuickTime Broadcaster and QTSS on separate computers.
Ways to Receive Streamed Media

When you watch and listen to cable or over-the-air media transmissions on television or radio, the cable or electromagnetic wavelengths used are dedicated to that transmission. Those transmissions are mostly uncompressed and consume large amounts of transmission bandwidth. It’s not a problem, because they don’t have to compete with other transmissions within the frequency over which they’re broadcast.

When you send that same media over the Internet, the bandwidth used is no longer dedicated to only that transmission stream. The media now has to share extremely limited bandwidth with thousands, potentially millions, of other transmissions traveling back and forth over the Internet. Therefore, before multimedia is sent over the Internet, it is encoded and compressed for transmission. The resulting files are saved in a specific location, and streaming server software such as QuickTime Streaming Server sends the media over the Internet to client computers.

Macintosh and Windows users can view streamed media with QuickTime Player (available free on the Apple website) or any other application that supports QuickTime or standard MPEG-4 files. You can also set up streams that users can view from within a web browser (they must have the QuickTime plug-in installed). When a user starts to play streamed media on a webpage, the QuickTime plug-in sends a request to the streaming server, and the server responds by sending the multimedia content to the client computer. You specify on the webpage what content to send to the client—a QuickTime movie in a specified directory, a live broadcast, or a playlist on the streaming server. 3GP streams can be viewed on streaming-enabled cell phones.
Multicast Versus Unicast

QuickTime Streaming Server supports both multicast and unicast network transport to deliver streaming media.

In a multicast, a single stream is shared among the clients (see illustration below). Each client “tunes in” to the stream much as a radio tunes in to an FM broadcast. This technique reduces network congestion, but it requires a network that either has access to the multicast backbone (the “Mbone”) for content distributed over the Internet, or is multicast-enabled for content distributed within a contained private network.

In a unicast, each client initiates its own stream, resulting in the generation of many one-to-one connections between client and server (see illustration below). Many clients connected via unicast to a stream in a local network can result in heavy network traffic. But this technique is the most reliable for delivery over the Internet since no special transport support is required.
Relays
QuickTime Streaming Server can also function as a relay server, allowing you to scale streaming infrastructure by distributing the load between servers and making the most efficient use of network bandwidth. Relays are useful for broadcasts with numerous viewers in different locations.

When used as a relay server, QuickTime Streaming Server forwards a stream from a source (such as Live Broadcaster, QuickTime Streaming Server) to a destination server. Mainly used in the case of live streaming, relays are most commonly set up when there are viewers of the live broadcast in multiple locations (different buildings on a campus, different countries). The source server generally resides in the location where the live broadcast is occurring and then forwards the stream to the servers in the various locations.

For example, a company can broadcast a CEO’s presentation by relaying it from headquarters to branch offices.
In this scenario, there is only a single stream going over the open Internet and viewers in the branch offices connect to the destination servers on the local area network (LAN) thus reducing the load on the source server creating a better viewing experience for everyone.

For detailed information about setting up relays, see “Setting Up Relay Streams” on page 31.
Setting Up Your QuickTime Streaming Server

This chapter is designed to help you quickly get your QuickTime Streaming Server up and running.

The instructions in this chapter assume that you have already installed and performed a basic setup of Mac OS X Server version 10.4. For instructions on setting up Mac OS X Server, see *Mac OS X Server Getting Started for Version 10.4 or Later* (included on a Mac OS X Server installation disc and downloadable at www.apple.com/server/documentation/).

Hardware and Software Requirements for QuickTime Streaming

QuickTime Streaming Server requirements are provided in the getting started guide.

**Viewer Computer Requirements**

Any computer with QuickTime 4 or later installed can view media streamed by the streaming server. For best results, Apple recommends QuickTime 7 or later.

QuickTime 6 and a broadband Internet connection are required to take advantage of Instant-On using QuickTime Streaming Server 4.1 or later.

Any ISO-compliant MPEG-4 player can view MPEG-4 files and any 3GP-compliant devices can view .3GP files. Streaming MP3 playlists can be listened to using iTunes or other compatible streaming MP3 player such as WinAmp.

You can download QuickTime Player software from the QuickTime website: www.apple.com/quicktime/

**Live Broadcasting Requirements**

If you want to broadcast live content, you can use QuickTime Broadcaster, which is included and installed with Mac OS X Server. For setup and other information, see the Apple QuickTime Broadcaster webpage (www.apple.com/quicktime/products/broadcaster/) and QuickTime Broadcaster online help.
You need the following equipment to stream live audio or video:
- Source equipment for audio, video, or both, such as a VCR, video camera, and microphone.
- A computer with QuickTime Broadcaster or other broadcast software (G4 computer recommended for MPEG-4 broadcasting) and a video or audio capture card.
  
  **Note:** QuickTime Broadcaster supports video capture from most FireWire-equipped sources, including digital video (DV) cameras, some webcams, and DV converter boxes for a fast and easy broadcasting process with professional-quality results.
- 128 MB of RAM (256 MB recommended for professional broadcasting).
- QuickTime 6 or later.

**Bandwidth Considerations**

It’s generally not a good idea to connect a streaming server to the Internet or local area network by Digital Subscriber Line (DSL) or cable modem. The server will be severely limited by the relatively small bandwidth of DSL and cable modems for uploading data. In some cases, running a server on a DSL connection may break a DSL service agreement. Consult your DSL or cable modem service provider before setting up the server.

When authoring Real-Time Transport Protocol (RTSP) streams, you’ll get best performance if the streams don’t exceed 75 percent of anticipated client bandwidth. For example, don’t use a rate higher than 21 kilobits per second (Kbps) for a 28 Kbps modem connection. For a typical 56K modem connection, don’t use a rate higher than 40 Kbps. For a T1 (1500 Kbps) client connection, don’t use a rate higher than 1125 Kbps.

**Setting Up Your Streaming Server**

You can set up your streaming server, test your setup, and access media streamed from your server.

**To set up your streaming server:**

1. Open Server Admin.
2. In the Computers & Services list, select the computer you want to set up as a QuickTime Streaming Server and make sure you can see all of its services (click the triangle next to the computer if you can’t see the services).
3. In the Computers & Services list, click QuickTime Streaming.
4. Click Start Service.
Testing Your Setup

Sample QuickTime movies are included with QTSS in the default movie folder so you can test the server setup. The sample movies can be viewed from a client computer using QuickTime Player.

Note: The included sample .mp3 file is for use in a streaming MP3 playlist only. It is not a hinted QuickTime movie and cannot be streamed on demand via RTSP. For information on preparing MP3 and other prerecorded media for simulated live streaming, see “Preparing Prerecorded Media for Streaming” on page 43.

To test your server setup by viewing a sample movie:
1. On another computer, open QuickTime Player.
2. Choose File > Open URL in New Player.
3. Enter the following URL:
   \[rtsp://hostname/sample_300kbit.mov\]
   where hostname is the host name or IP address of the QuickTime streaming server. Choose the movie with the bit rate appropriate for your bandwidth.
4. Click OK.
   QuickTime Player connects with the server and plays the movie in a new window.

If you see a “File not found” message:
First make sure the URL was typed correctly, including uppercase and lowercase restrictions.

If your streaming server is multihomed (for example, if the computer also hosts a web server), then you may need to specify another IP address for streaming. (A web server automatically uses port 80; with certain QuickTime client configurations, QTSS also uses port 80.) You can choose or add an IP address for the streaming server in the QuickTime Streaming pane of Server Admin. Click Settings, click IP Bindings, and then select the Bind checkbox for the desired IP address.

This concludes the initial setup of your streaming server software. Additional settings depend on your hardware and software, network connections, expected number of viewers, and media you want to stream. For information about determining these settings and operating your streaming server, see Chapter 3, “Managing Your QuickTime Streaming Server,” Chapter 6, “Setup Example,” and the resources listed on page 13.
Accessing Media Streamed From Your Server

To view streaming media, users must have QuickTime 4 or later (or an MP4 player). Following are the instructions to provide to users who want to view media streamed from your server.

To view streamed media:

1. Open QuickTime Player.
2. Choose File > Open URL.
3. Enter the URL for the media file. For example:
   rtsp://myserver.com/mymedia

   where myserver.com is the DNS name of the QTSS computer and mymedia is the name of the hinted movie or media file.

   This URL assumes that the movie or media file is located at the top level of the media directory. For movies in subfolders within the media directory, add the folder to the pathname. For example:
   rtsp://myserver.com/myfolder/mymedia.mov

   If you want users to view streamed media through a web browser, you must set up a webpage to show the media (see “Creating Webpages” on page 48) and give users the page’s URL. Typing an RTSP URL directly into the web browser’s address field is not recommended (some web browsers don’t understand “rtsp”).
Managing Your QuickTime Streaming Server

This chapter provides information about streaming past firewalls, setting up relays, and administering a QuickTime Streaming Server remotely.

To set up and manage QuickTime Streaming Server (QTSS), you use the Server Admin application, which is installed with Mac OS X Server (version 10.4 or later). This application provides a standard graphical user interface for all supported platforms and enables you to administer the streaming server locally or remotely. You use Server Admin to change general settings, monitor connected users, view log files, manage bandwidth usage, and relay streams from one server to another.
Here is a brief description of the five panes in QuickTime Streaming:

- **Overview:** Provides a snapshot of current server activity.
- **Logs:** Displays error logs for troubleshooting purposes and access logs, which show such information as the number of times a media file has been accessed and when.
- **Connections:** Provides information about connected users and active relays.
- **Graphs:** Displays a graph of the average number of connected users or throughput over time, from hours to days.
- **Settings:** Where you specify server settings, bind QTSS to specific IP addresses (if the server computer is multihomed), enable relays, and change log settings.

Also included with QTSS is QuickTime Streaming Server Publisher, an application that automates the process of preparing and delivering streaming movies. Its user-friendly interface makes it easy to post error-free streaming content on the web. You use QTSS Publisher to create playlists, automatically hint movies, and easily embed movies in a website. For more information about QTSS Publisher, see Chapter 4, “Managing Your Media With QTSS Publisher,” on page 41.

**Using the Web-Based Application to Manage QuickTime Streaming**

If you have previously administered a QuickTime Streaming Server using the web-based application, Web Admin, you can continue to do so. Web Admin is useful for administering a streaming server remotely or from non-Macintosh computers.

**To use Web Admin:**

1. In Server Admin, select QuickTime Streaming under the server in the Computers & Services list.
2. Click Settings.
3. Click Access.
4. Select “Enable web-based administration.”
5. Click Save.

For information on using Web Admin, see the QuickTime Streaming Server/Darwin Streaming Server administrator’s guide available at developer.apple.com/darwin/.

**Note:** If you have been using the web-based application, Web Admin, to administer a QuickTime Streaming Server, you’ll find the administration features in Mac OS X Server Admin. Use QTSS Publisher to create playlists and to prepare and organize media files.
Using Server Admin to Manage QuickTime Streaming
This section provides instructions for tasks such as streaming, setting up a multihomed server, and changing such settings as the maximum number of connections and the maximum throughput allowed.

Starting or Stopping Streaming Service
You start or stop streaming service in the QuickTime Streaming pane of Server Admin.

To start or stop streaming service:
1 Open Server Admin.
2 In the Computers & Services list, click QuickTime Streaming for the server.
3 At the top of the window, click Start Service or Stop Service.

Changing the Maximum Number of Stream Connections
When the specified maximum number of connections is reached, users who try to connect see a message that the server is busy or there is not enough bandwidth (error 453).

To change the maximum number of connections:
1 In Server Admin, click QuickTime Streaming under the server in the Computers & Services list.
2 Click Settings.
3 Enter a number in the Maximum Connections text field.
4 Click Save.

Changing the Maximum Streaming Throughput
If the maximum throughput is reached, no one else can connect. Users who try to connect see a message that the server is busy (error 453).

To change the maximum throughput:
1 In Server Admin, click QuickTime Streaming under the server in the Computers & Services list.
2 Click Settings.
3 Enter a number in the Maximum Throughput text field, and choose megabits per second (Mbps) or kilobits (Kbps) from the pop-up menu.
4 You can specify whether to bind QTSS to all listed IP addresses or to selected addresses only.
5 Click Save.
Changing the Streaming Media Directory
QuickTime Streaming Server has one main media directory (/Library/QuickTimeStreaming/Movies/). If you have a reason to specify another directory for your streaming media (for example, you might want to switch the directory to another hard disk), you can do so. You must ensure that the owner of the new directory is the system user “qtss”. The owner can be changed from Workgroup Manager, the Finder, or the command line.

To specify another media directory:
1. In Server Admin, click QuickTime Streaming under the server in the Computers & Services list.
2. Click Settings.
3. Enter a pathname in the Media Directory text field or click the button next to the field to choose a folder.
4. Click Save.

Binding the Streaming Server Admin Computer to an IP Address
If your streaming server admin computer is multihomed (for example, if you’re also hosting a web server), you can specify what IP address QTSS should bind to.

To specify an IP address:
1. In Server Admin, click QuickTime Streaming.
2. Click Settings, then click IP Bindings.
3. Select the Bind checkbox for the desired IP address.
4. Click Save.

Hosting Streams From Multiple User Media Directories
QuickTime Streaming Server can have only one main media directory. By enabling home directory support, however, users can stream on-demand files or playlists from their home directory.

To configure QTSS to stream movies located in users’ home directories:
1. In Server Admin, click QuickTime Streaming.
2. Click Settings, then click Access.
3. Select “Enable home directory streaming.”
4. Click Save.
5 Ask users to put their hinted QuickTime movies into the folder that was created in their home directories (/<username>/Sites/Streaming).

To view a movie in a private movie directory, enter the URL:
rtsp://hostname.com/~user1/sample.mov

Note: To stream a live broadcast from a directory other than the media directory, you need to create a qaccess file. For more information, see the QuickTime Streaming Server administrator’s guide available at developer.apple.com/darwin/.

Setting Up Relay Streams
You use relays to accept a stream from one streaming server and send the stream on, or “relay” it, to another streaming server. Each relay comprises a source and one or more destinations.

To set up a relay:
1 In the Settings pane of the QuickTime Streaming service, click Relays.
2 Click the Add (+) button next to the Relays list.
3 Enter a name for the relay in the Relay Name field.
4 Choose an option from the Relay Type pop-up menu.
   The Relay Type defines the source for the relay. There are three different options for Relay Type:
   
   Request Incoming Stream directs the streaming server to send a request to the source computer for the incoming stream before it gets relayed. You can use this feature to relay a reflected live broadcast (from another server) or to request a stored file and turn it into an outgoing live stream. Request Incoming Stream is commonly used with unannounced UDP streams from QuickTime Broadcaster or other streaming encoders.

   Unannounced UDP directs the server to relay streams on a specific IP address and port numbers.

   Announced UDP directs the server to wait for the incoming stream and then relay it. Relays set to wait for announced streams can accept only media streams using the RTSP announce protocol. Announced UDP is used with Automatic (Announced) broadcasts from QuickTime Broadcaster or other streaming encoders that support the RTSP announce protocol.

5 In case of Request Incoming Stream or Announced UDP, in the Source IP field, enter the DNS hostname or IP address of the source computer.
6 In case of Request Incoming Stream or Announced UDP, in the Path text field, enter the pathname to the stream.
7 In case of Request Incoming Stream or Announced UDP, if the source computer requires automatic broadcasts to be authenticated, enter a user name and password.
8 Make sure Enable Relay is selected and click the Back button.
Click the Add (+) button next to the Destinations list.

There are two different types of destinations:
- Unannounced UDP directs the server to relay the stream to the destination IP address and port numbers. This requires generating an SDP file manually.
- Announced UDP directs the server to relay and announce the stream to the destination IP address. The SDP file will be generated automatically at the destination.

Enter the requested information and click the Back button.

Repeat steps 9 and 10 for each destination, then click Save.

To turn a relay on or off, select or deselect the Enable checkbox next to the relay in the list. To delete a relay, select it and click the Delete (−) button.

Changing QuickTime Streaming Log Settings
You can specify that each log be reset after a certain number of days.

To change log settings:
1 In Server Admin, click QuickTime Streaming under the server in the Computers & Services list.
2 Click Settings.
3 Click Logging.

The Access Log is updated only as client connections are disconnected. Any currently connected clients at the time of a power failure or server crash are never logged, and won’t appear in the Access Log when the server is restarted.

Log files are stored in /Library/QuickTimeStreaming/Logs/.

Reading QuickTime Streaming Logs
The QuickTime Streaming Server service in Mac OS X Server provides the following log files:
- Error logs. These log files report errors such as configuration problems. (For example, if you bind to a specific IP address that can’t be found, or a user has deleted streaming files.)
- Access logs. When someone plays a movie streamed from your server, the log reports such information as the date, time, and IP address of the computer that played the movie.

QTSS log files are stored in /Library/QuickTimeStreaming/Logs.

QTSS keeps its logs in standard W3C format allowing you to use a number of popular log analysis tools to parse the data.
Security and Access

A certain level of security is inherent in real-time streaming, since content is delivered only as the client needs it and no files remain afterward, but you may need to address some security issues.

The streaming server uses the IETF standard RTSP/RTP protocols. RTSP runs on top of TCP, while RTP runs on UDP. Many firewalls are configured to restrict TCP packets by port number, and are very restrictive on UDP.

There are three options for streaming through firewalls with the streaming server. These options are not mutually exclusive. Typically one or more are used to provide the most flexible setup. The three configurations outlined below are for clients behind a firewall.

• **Stream via port 80.** This option enables the streaming server to encapsulate all RTSP and RTP traffic inside TCP port 80 packets. Because this is the default port used for HTTP-based web traffic, it gets through most firewalls. However, encapsulating the streaming traffic lowers performance on the network and requires faster client connections to maintain streams. It also increases load on the server.

• **Open the appropriate ports on the firewall.** This option allows the streaming server to be accessed via RTSP/RTP on the default ports, and provides better use of network resources, lower speeds for client connections, and less load on the server. The ports that need to be open for unrestricted streaming include:
  - TCP port 80: Used for signalling and streaming RTSP/HTTP (if enabled on server)
  - TCP port 554: Used for RTSP
  - UDP ports 6970–9999: Used for UDP streaming (a smaller range of UDP ports, typically 6970-6999, can usually be used)
  - TCP port 7070: Optionally used for RTSP (Real Server uses this port; QTSS/Darwin can also be configured to use this port)
  - TCP ports 8000 and 8001 can be opened for Icecast MP3 streaming. Also see the port information in the table on page 62.

• **Set up a streaming proxy server.** The proxy server is placed in the network DMZ—an area on the network that is between an external firewall to the Internet and an internal firewall between the DMZ and the internal network. Using firewall rules, packets with the ports defined above are allowed from the proxy server to clients through the internal firewall, and also between the proxy server and the Internet via the external firewall. However, clients are not allowed to make direct connections to external resource over those ports. This approach ensures that all packets bound for the internal network come through the proxy server, providing an additional layer of network security.
Serving Streams Past Firewalls Using Port 80
If you are setting up a streaming server on the Internet and you think some of your clients are behind firewalls that allow only web traffic, enable streaming on port 80. With this option, the streaming server accepts connections on port 80, the default port for web traffic, and QuickTime clients can connect to your streaming server even if they are behind a web-only firewall. If you enable streaming on port 80, make sure you disable any web server with the same IP address to avoid conflicts with your streaming server.

To serve QuickTime streams over HTTP port 80:
1. In Server Admin, click QuickTime Streaming under the server in the Computers & Services list.
2. Click Settings.
3. Click IP Bindings.
4. Select “Enable streaming on port 80.”

Important: If you enable streaming on port 80, make sure that your server is not also running a web server, such as Apache. Running both QTSS and a web server with streaming on port 80 enabled can cause a port conflict that results in one or both of the servers not behaving properly.

Streaming Past Firewalls or Networks With Address Translation
The streaming server sends data using User Datagram Protocol (UDP) packets. Firewalls designed to protect information on a network often block UDP packets. Client computers located behind a firewall that blocks UDP packets can’t receive streamed media. However, the streaming server also allows streaming over HTTP connections, which allows streamed media to be viewed through even very tightly configured firewalls.

Some client computers located on networks that use address translation may also be unable to receive UDP packets, but they can receive media that’s streamed over HTTP connections.

If users have problems viewing media through a firewall or via a network that uses address translation, they should upgrade their client software to QuickTime 5 or later. If users still have problems, their network administrators should provide them with the appropriate settings for the streaming proxy and streaming transport settings on their computers.

Network administrators can also set their firewall software to permit RTP and RTSP throughput.
Changing the Password Required to Send an MP3 Broadcast Stream
Broadcasting MP3s to another server requires authentication.

To change the MP3 broadcast password:
1. In Server Admin, click QuickTime Streaming under the server in the Computers & Services list.
2. Click Settings, then click Access.
3. Type a new password in the MP3 Broadcast Password box.
4. Click Save.

Using Automatic Unicast (Announce) With QTSS on a Separate Computer
You can broadcast from QuickTime Broadcaster to QuickTime Streaming Server. This setting can also be used to receive Announced UDP streams from another QuickTime Streaming Server via a relay using the Automatic Unicast (Announce) transmission method. To do so, you need to create a broadcast user name and password on the streaming server.

To create a broadcast user name and password on the streaming server:
1. In Server Admin, click QuickTime Streaming under the server in the Computers & Services list.
2. Click Settings, then click Access.
3. Select the “Accept incoming broadcasts” checkbox.
4. Click Set Password and enter the name and password.
5. Click Save.

Advanced Management Tasks
In addition to what is available via the Server Admin user interface, QuickTime Streaming Server also includes a number of advanced features that allow for even further customization of the server but are only available from the command line. These features include creating QTSS users and groups with qtaccess files, controlling access to content, and setting up multicast relays.

Controlling Access to Streamed Media
You can set up authentication to control client access to streamed media files. Two schemes of authentication are supported: basic and digest. By default, the server uses the more secure digest authentication.
You can also control playlist access and administrator access to your streaming server. Authentication does not control access to media streamed from a relay server. The administrator of the relay server must set up authentication for relayed media.

The ability to manage user access is built into the streaming server, so it is always enabled.

For access control to work, an access file must be present in the directory you selected as your Media Directory. If an access file is not present in the streaming server media directory, all clients are allowed access to the media in the directory.

To set up access control:
1. Use the qtpasswd command-line utility to create new user accounts with passwords.
2. Create an access file and place it in the media directory that you want to protect.
3. If you want to disable authentication for a media directory, remove the access file (called qtaccess) or rename it (for example, qtaccess.disabled).

Creating an Access File
An access file is a text file called qtaccess that contains information about users and groups who are authorized to view media in the directory in which the access file is stored. The directory you use to store streamed media can contain other directories, and each directory can have its own access file. When a user tries to view a media file, the server checks for an access file to see whether the user is authorized to view the media. The server looks first in the directory where the media file is located. If an access file is not found, it looks in the enclosing directory. The first access file that’s found is used to determine whether the user is authorized to view the media file.

The access file for the streaming server works like the Apache web server access file.

You can create an access file with any text editor. The filename must be qtaccess and the file can contain some or all of the following information:

AuthName <message>
AuthUserFile <user filename>
AuthGroupFile <group filename>
require user <username1> <username2>
require group <groupname1> <groupname2>
require valid-user
require any-user

Terms not in angle brackets are keywords. Anything in angle brackets is information you supply.

Save the access file as plain text (not .rtf or any other file format).
message is text your users see when the login window appears. It’s optional. If your message contains any white space (such as a space character between terms), make sure you enclose the entire message in quotation marks.

user filename is the path and filename of the user file. For Mac OS X, the default is /Library/QuickTimeStreaming/Config/qtusers.

group filename is the path and filename of the group file. For Mac OS X, the default is /Library/QuickTimeStreaming/Config/qtgroups. A group file is optional. If you have a lot of users, it may be easier to set up one or more groups, and then enter the group names, than to list each user.

username is a user who is authorized to log in and view the media file. The user’s name must be in the user file you specified. You can also specify valid-user, which designates any valid user.

groupname is a group whose members are authorized to log in and view the media file. The group and its members must be listed in the group file you specified.

You can use these additional user tags:

• valid-user is any user defined in the qtusers file. The statement “require valid-user” specifies that any authenticated user in the qtusers file can have access to the media files. If this tag is used, the server will prompt users for an appropriate user name and password.

• any-user allows any user to view media without providing a name or password.

You can also add the keyword AuthScheme with the values “basic” or “digest” to a qtaccess file. This overrides the global authentication setting on a directory-by-directory basis.

If you have made customized changes to the default qtaccess access file, be aware that making any changes to broadcast user settings in Streaming Server Admin will modify the default qtaccess file at the root level of the Movies directory. Any customized modifications you may have made prior to this will not be preserved.

What Clients Need to Access Protected Media

Users must have QuickTime 5 or later to access a media file for which digest authentication is enabled. If your streaming server is set up to use basic authentication, users need QuickTime 4.1 or later. Users must enter their user names and passwords to view the media file. Users who try to access a media file with an earlier version of QuickTime will see the error message “401: Unauthorized.”
Adding User Accounts and Passwords
You can add a user account and password if you log in to the server computer.

To add a user account:
1 Log in to the server computer as root, open a terminal window, and type the following:
   ```bash
   qtpasswd <user-name>
   ```
   Alternatively, use `sudo` to execute the command as root.
2 Enter a password for the user and reenter it when prompted.

Adding or Deleting Groups
You can edit the `/Library/QuickTimeStreaming/Config/qtgroups` file with any text editor as long as it follows this format:

```
<groupname>: <user-name1> <user-name2> <user-name3>
```

For Windows, the path is `c:\Program Files\Darwin Streaming Server\qtgroups`. For other supported platforms, it is `/etc/streaming/qtgroups`.

To add or delete a group, simply edit the group file you set up.

Making Changes to the User or Group File
You can make changes to the user or group file if you log in to the server computer.

To delete a user from a user or group file:
1 Log in to the server computer as administrator and use a text editor to open the user or group file.
2 Delete the user name and encrypted passwords line from the user file.
3 Delete the user name from the group file.

To change a user password:
1 Log in to the server computer as root, open a terminal window, and type the following:
   ```bash
   qtpasswd <user-name>
   ```
   Alternatively, use `sudo` to execute the command as root.
2 Enter a new password for the user.
   The password you enter replaces the password in the file.
Configuring a Multicast Relay

Setting up a multicast relay allows you to receive a unicast stream from one server and relay it out to a local area network over multicast (note that network must be multicast enabled for viewers to be able to access the stream). The following steps show how this is set up.

To relay an incoming stream as a multicast stream:

1. Set up a multicast relay on the streaming server.
   a. If the broadcast source for the relay is configured as an Automatic Unicast (Announce), set the Relay Type to “Announced UDP.” If the broadcast source for the relay is configured as a Manual Unicast, set the Relay Type to “Request Incoming Stream.”
   b. Set the “Source IP” of the relay to 127.0.0.1.
   c. Set the path to the Announced (specified in step 2) or Unannounced sdp file (manually copied to the server) as the “Path” for the relay. This path is relative to your streaming server’s Movies directory. Make sure to include the “.sdp” extension.
   d. If you are using Automatic Unicast on the Broadcaster/Encoder, select “Announced UDP” for the Relay Type. If the source is a manual unicast, select “Request Incoming Stream.”
   e. Leave User Name and Password fields blank. When using the loopback address (127.0.0.1), authentication is not required.
   f. Create a destination for the relay by clicking the “+” icon. Specify a valid multicast address for the Destination IP address. Set the Destination type to “Unannounced UDP.” Set the UDP base port number to an even number (something in the 9000–9996 range works well). The multicast TTL is the number of router hops the multicast will work through. Set it for the topology of the network you are working on.
   g. Click the Save button.

2. Set up QuickTime Broadcaster to send an “Automatic Unicast (Announce)” or “Manual Unicast” to the server.

   For Automatic Unicasts, the filename specified in Broadcaster will be created on the server (the .sdp extension will be added if not specified). More information on Automatic Unicast is available on page 35. For Manual Unicast, the .sdp file must be Exported from Broadcaster and manually copied to the Streaming Server’s Movies directory. After you start the broadcast, test the reflected stream from the server in QuickTime Player by opening this URL:
   rtsp://<serverIP>/<filename.sdp>

3. To enable clients to tune in to the multicast relay, make a copy of the SDP file and edit the copy as follows:
   a. In the line that begins with c=IN IP4, change the IP address to the multicast IP address specified in step 1.
b In the first line beginning with `m=` (usually `m=audio`), change the 0 to the base port specified in step 1 (for example, 9000).

c In the next line beginning with `m=` (usually `m=video`), change the 0 to the base port plus 2 (9002).

4 Save the file where clients can access it:

- via HTTP
- via FTP
- on a file server
- on a web server
- as an email

If you put the file on an HTTP or FTP server, clients can access the multicast in QuickTime Player by opening one of these URLs:

- `http://<webServerIP>/<pathAndFileNameOfsdpFile>`
- `ftp://<ftpServerIP>/<pathAndFileNameOfsdpFile>`

If you put the multicast SDP file on a web server or email it to clients, they can open it in QuickTime Player.

If you place the multicast SDP file on a web server, the MIME type needs to be configured properly on the web server by entering:

```
mime type extension application/sdp sdp.
```

Alternatively, you can open the SDP file or URL in QuickTime Pro, save the file as a self-contained .mov file, and then send the file to clients (or embed it in a webpage and so on).

As long as the broadcast SDP filename isn’t changed, you can stop and start new broadcasts using the same name. However, if you change any parameters in the SDP file, you’ll need to complete steps 3 and 4 for each new broadcast.
Managing Your Media With QTSS Publisher

This chapter provides information about using the QuickTime Streaming Server Publisher application to prepare, organize, and upload media for streaming.

QuickTime Streaming Server Publisher makes it easy to prepare and deliver streaming movies on the Internet. The QTSS Publisher application comes with Mac OS X Server version 10.4 (or later); it is in /Applications/Server/.

Users who aren't server administrators can install QTSS Publisher from the administration tools CD that comes with Mac OS X Server, or can simply drag the application from a server to their hard disk.

Important: You can use QTSS Publisher locally on a computer running Mac OS X Server version 10.4 or later, or remotely on a computer running Mac OS X version 10.3 or later. When you open QTSS Publisher, you must enter a user name and password for a Mac OS X Server (version 10.4 or later) user account.

Overview of QTSS Publisher

With QTSS Publisher, you can manage all of your QuickTime media on Mac OS X Server, from uploading to streaming. If you previously used the web-based application, Web Admin, to create MP3 and movie playlists, you can now use the more Mac-like interface of QTSS Publisher to create playlists and more. With QTSS Publisher, you can:

- Upload media to the server
- Prepare media for streaming or progressive download
- Create MP3, MP4, 3GP, and movie playlists
- Create webpages with QuickTime media
Here is an overview of the main QTSS Publisher window:

**About Playlists and Hinting**

You can add media and MP3 files to the QTSS Publisher library to prepare them for streaming or to create playlists from them.

A *playlist* is a set of media files (QuickTime movies, 3GP, MPEG-4 files, or MP3 audio tracks) that you choose and arrange. You can create a virtual "radio station" or a simulated live video broadcast by creating a playlist (or a series of playlists) of prerecorded QuickTime media, MPEG-4, 3GP, or MP3 files. The playlists broadcast the media to the streaming server, which sends the media to users who request it, in the sequence you set up (random or ordered). Although the media is prerecorded, it appears to users as a live broadcast; all users see and hear the same thing when they tune in to the broadcast. Listeners can tune in to a video broadcast on the web and to an MP3 playlist using iTunes or another compatible streaming MP3 player.

Before you stream a movie (a 3GP, mov, or .MP4 file), it must be *hinted*. Hint tracks contain information the streaming server needs to stream the media properly; they allow the streaming server to stream QuickTime movies without having to understand QuickTime media types or codecs. QTSS Publisher automatically adds hint tracks to the items in a playlist as needed. (MP3 playlists don’t need to be hinted.)

**Note:** You can set up QuickTime Pro to export a QuickTime movie with all the necessary hint tracks.
Connecting to Mac OS X Server
When you open QTSS Publisher, you must provide a user name and password for a Mac OS X Server (version 10.4 or later) user account. Local users can log in if home directory streaming has been enabled for them (see “Hosting Streams From Multiple User Media Directories” on page 30).

If the attempt to log in fails, make sure that the server you’re trying to connect to is running. Also make sure that port 311 is not disabled by your firewall.

Uploading Media From QTSS Publisher to a QuickTime Streaming Server
Files you drag to the QTSS Publisher Library are automatically uploaded to the server you’re connected to, but the media is not accessible to the public until you make it available (see “Making Content Available for Streaming or Downloading” on page 48). You can use QTSS Publisher as a staging area to prepare your content for web delivery.

Preparing Content for Web Delivery
After you upload your content to the server (by dragging files to the QTSS Publisher window), and before you make your content available to the public, you may need to prepare your files for delivery over the Internet. This section describes the process.

Preparing Prerecorded Media for Streaming
Before prerecorded media can play as a simulated live stream in a playlist, the media needs to be prepared for streaming.

To prepare prerecorded media for broadcast in a playlist:
1 For movie playlists, make sure each movie has the same number and types of tracks, and that all the media files contain compatible media types. For example, all audio tracks should use the same encoding, sampling rate, compression, and bit rate. All video tracks should also use the same encoding, compression, bit rate, and frame size.
2 Format the media in each file in the same way. For a movie playlist, be sure each media file is a hinted QuickTime movie, a hinted MPEG-4 file, or a hinted 3GP file. (If you put your files in the QTSS Publisher Library, they are hinted for you.) Do not hint MP3 files.
3 Open QTSS Publisher (in /Applications/Server) and click Library.
4 Drag media files from the Finder to the QTSS Publisher library list.

Important: QTSS support of MP3 streams is intended for Shoutcast/Icecast-compatible live streams (such as those created by a streaming playlist) or live streams of other compatible MP3 live encoder broadcasters. To serve an individual MP3 file on demand (not as a live stream), select the file in the Library and then select “Publish MP3 file to web server” (also called “Fast Start” in the User Access area of the QTSS Publisher window).
Improving the Performance of Hinted Movies Exported From QuickTime Player

When you export a hinted movie from QuickTime Player, you can compress video and sound using either the native RTP payload encoder or the generic QuickTime payload encoder. Generally, native payload encoding is preferred. Check with your codec manufacturer for specific guidelines regarding payload encoding. Use care and experimentation when choosing between native and QuickTime payload encoders.

To change the encoding used when you export from QuickTime Player:

1. Choose File > Export.
2. Choose “Movie to Hinted Movie” from the Export pop-up menu.
3. Click Options and then click Track Hinter Settings.
4. Choose an option from the RTP Payload Encoding pop-up menu.

To maximize the number of connected users—rather than saving disk space—select the “Optimize hints for server” checkbox. (In most cases, you’ll want to leave the checkbox deselected.)

Choosing a Thumbnail for a Movie on a Webpage

When you use QTSS Publisher to embed a streaming movie in a webpage, you can choose a custom image to display until the movie starts playing. If you don’t choose a custom image, the movie’s poster frame (the first image or the frame selected in QuickTime) is displayed.

To select a still image to represent an embedded movie:

1. In QTSS Publisher, click Library or the playlist and then select the movie.
2. If you have an individual file you want to use as the poster frame, select Custom Image, click Choose, and select the file. Or drag the file from the Finder to the Thumbnail Image well in QTSS Publisher.
3. Click Apply.

If you don’t have a separate file, select the movie in the Finder (use Column view), play the movie in the Preview column, click Pause when the desired frame appears, and drag from the Preview window to the Thumbnail Image well.
Creating and Editing Movie Annotations
You can create annotations to preserve information about a movie, such as its author, copyright date, and notes. The text in the Full Name annotation field appears as the title in a QuickTime Player window. The other fields appear in the movie Properties window in QuickTime Player (Movie > Get Movie Properties).

To annotate a movie:
1 In QTSS Publisher, click Library and then select the movie.
2 Type the information in the Movie Annotations fields.
3 Click Apply.

Specifying Where to Play Media on a Webpage
For media files accessed on a webpage, you can make the media file play as soon as the webpage opens or when a user clicks the file's still image. You can also specify whether the movie plays within the webpage or in QuickTime Player.

To specify how media plays:
1 In QTSS Publisher, select the media file or playlist.
2 Under HTML Settings, choose an option from the pop-up menu.
   - **Open in QuickTime Player:** When the user clicks the still image on the webpage, the movie starts playing in a separate QuickTime Player window.
   - **Embed in webpage:** When the user clicks the still image on the webpage, the movie starts playing within the webpage.
   - **Autoplay in webpage:** The movie starts playing as soon as the webpage loads (the still image isn't displayed).
3 Click Apply.

Creating and Managing Playlists
With QTSS Publisher, it's easy to create and manage playlists for video or audio broadcasts.

Creating a Playlist of Media for Streaming
You can create a playlist of QuickTime movies, MPEG-4 files, or MP3 audio tracks.

To create a playlist:
1 Make sure your prepared media files are in the QTSS Publisher Library (drag them from the Finder to the library list).
2 In QTSS Publisher, choose File > New Collection or click the New (+) button.
3 Choose Media Playlist or MP3 Playlist from the pop-up menu.
4 Type a name for the playlist. (You can change the name later.)
As you enter the name, QTSS Publisher creates a URL name for you (you can change the URL name if you wish). The playlist and URL names must be unique; no two broadcasts can use the same name.

5 Click Create.

6 When the new playlist appears in the sidebar (on the left of the QTSS Publisher window), you can drag files to it from the Library.

Starting and Stopping Playlists
You start or stop broadcasting playlists using QTSS Publisher.

To start or stop broadcasting a playlist:
1 In QTSS Publisher, select the playlist.
2 Click the Start or Stop button.
3 If you are stopping a playlist, you can select the "Wait" checkbox so that the playlist stops when the currently playing item finishes.

Modifying a Playlist
To change the order of items in a playlist, drag them. To delete an item from a playlist, select it and press Delete. To add items to a playlist, drag them from the Library to the playlist name in the sidebar.

Note: You can change a playlist’s content without stopping and restarting it—the playlist updates automatically. You can change a playlist’s settings (for example, whether the playlist plays in random or sequential order) while it is broadcasting, but you must stop and restart the playlist to apply the new settings.

You can also modify settings such as the playlist’s name, genre, and play mode.

To change a playlist’s name or genre:
1 In QTSS Publisher, select a playlist.
2 In the Playlist Settings area, make your changes.
3 Click Apply.

Specifying How an MP3 Playlist Plays
You can set up a playlist to play in order once or repeatedly, or to play in random order. You can also weight individual items so that they play more often.

To specify how an MP3 playlist plays:
1 In QTSS Publisher, select the playlist.
2 Under Playlist Settings, choose an option from the Play Mode pop-up menu.

Sequential broadcasts the media in the order in which it appears in the playlist.
Sequential Looped broadcasts the playlist in order, and then, when the last media file ends, the playlist repeats in the same order.
**Weighted Random** broadcasts the media in random order, using the specified weights to determine how often an item plays (the higher the weight, the more often the item is played).

3 If you chose Weighted Random, you can specify the number of items that must be broadcast before an item repeats.

4 Click Apply.

**Changing the Weight of an Item in a Playlist**
You can "weight" a playlist item to adjust how often it plays. When you choose Weighted Random in the Play Mode pop-up menu, items with higher weights play more often than those with lower weights.

**To change an item's weight:**
1 In QTSS Publisher, select the playlist, then select the item.
2 Drag the Weight slider (farther right is higher).
3 Click Apply.

**Creating Playlist Hypertext and Captions**
When you use QTSS Publisher to upload an MP3 playlist, Publisher automatically creates a hypertext link for it. The default text is “Click here to listen,” but you can customize it. For MP3 and movie playlists, you can also create a caption to display on the webpage.

**To create a hypertext link and caption for an MP3 playlist:**
1 In QTSS Publisher, select the playlist.
2 Under Webpage Settings, type the text link and caption.
3 Click Apply.

To make a caption for a media file or playlist, select the item and type the text in the Webpage Caption field.
Delivering Your Content
After you prepare and organize your media, QTSS Publisher makes it easy to deliver your content over the Internet, by progressive download or streaming.

Making Content Available for Streaming or Downloading
Content in the QTSS Publisher Library is automatically uploaded to the server, but is not available for on-demand streaming until you make it available.

To make a playlist available, select the playlist and click Start. (See Chapter 3, “Starting or Stopping Streaming Service,” on page 29.)

To make an individual media file publicly available:
1 In QTSS Publisher, click Library, then select the media file.
2 For an MP3 file, select “Publish MP3 file to web server” under User Access. For a media file, select an option from the “Publish media to” pop-up menu:
   
   **Publish media file to QuickTime Streaming Server (Instant-On).** With Instant-On streaming, no file is downloaded to the client. This provides more protection for the media. It also gives clients the ability to move the playhead position forward without waiting for the media to download: Instant-On streaming is an excellent choice for longer media files (files that are more than 5 minutes in length).

   **Publish media file to web server (Fast Start).** Files can also be posted to the web server for Fast Start streaming. These files are downloaded to the client. Fast Start is ideal for shorter media files. It is also a good choice for clients with slower connections (56K modem).
3 Click Apply.

Specifying Which Server to Broadcast From
By default, playlists broadcast from the server you’re connected to, but you can specify another server to stream from.

To relay a broadcast through a different server:
1 In QTSS Publisher, select the playlist.
2 Under Broadcast Server, select “Relay broadcast through a different server.”
3 Enter the requested information.
4 Click Apply.

Creating Webpages
QTSS Publisher generates HTML for each playlist. To create a webpage link to a playlist, drag the HTML to your webpage editor.

You can also use QTSS Publisher to create webpages. Predesigned templates are provided, so you can create an attractive webpage without having to do a lot of design work. (See the sample below.)
To create a webpage:
1. In QTSS Publisher, choose File > New Collection or click the New (+) button.
2. Choose Webpage from the pop-up menu.
3. Type a name for the webpage. (You can change the name later.)
   The name you type will be the title on the webpage. As you enter the name, QTSS Publisher creates a URL name for you (you can change the URL name if you wish).
4. Click Create.
5. To put a media file or playlist on the webpage, click Library and drag the file to the webpage icon in the source list.
6. Click Open to open the webpage in a browser.

Users can access the webpage by typing the URL into their browser.

You can change the template the webpage uses at any time with the Template pop-up menu.
This chapter provides information on what to do if you encounter problems while streaming media.

Using Log Files to Monitor Playlist Broadcasts
If you enable logging, you can use the log file to troubleshoot problems that occur during a broadcast.

- If the media in the playlist is not being broadcast, check Streaming Server Admin to make sure the streaming server is running.
- If the streaming server is running, make sure a process called PlaylistBroadcaster is running on the server computer. If it is running, stop the broadcast, delete the SDP file for the broadcast from the streaming server media directory, then restart the broadcast. A new SDP file is generated when you restart the broadcast.

Media Files Don’t Stream Properly
Try streaming a sample movie to see if the server can stream it. Sample movies are included with the server.

If the server streams the sample movie, the problem may be with the way your movie file is prepared. Re-create the movie.

If the sample movie doesn’t stream, the problem may be with the server computer or the network.

- Check streaming server activity and, if necessary, reduce the maximum number of connections or throughput.
- If the problem occurs on a client computer, make sure the user has the appropriate Streaming Proxy and Streaming Transport settings. The administrator for the client computer’s network should be able to provide the correct settings.
- Make sure the client software supports the file format being broadcast.
- Check the structure of the URL.
- Check the playlist. If you created a looping playlist containing hinted MPEG-1 QuickTime files, QuickTime clients may have problems viewing the stream.
**Administrator Can’t Use QTSS Publisher to Publish Media**

Make sure your Mac OS X server has QTSS Publisher installed in the Server folder under Applications.

- If you are unable to create a playlist or add to an existing one, make sure the owner of the Media directory (specified in QuickTime Streaming in Server Admin) is “qtss”.
- Make sure the correct URL is being used (and has not been corrupted by user modification).
- To set up your IP bindings in QTSS Publisher, republish all of your media. This step is required if you change an address.
- Make a backup copy and delete /Library/Caches/com.apple.qtssserverpublisher.plist, which is a cache of all the information about QuickTime content. It can be useful to clear this cache (by deleting the file) if something goes wrong with QTSS Publisher that you cannot fix through any other means.

**Users Can’t Connect to Your Broadcast**

Make sure the client computer has QuickTime 4 or later installed. If users are connecting using a web browser, make sure the QuickTime 4 Plug-in is installed correctly.

- Make sure users have the correct URL.
- If users are attempting to connect to your broadcast over HTTP, make sure you disable any web server that may be conflicting with your streaming server. Also, make sure streaming on port 80 is enabled in the General Settings pane of Streaming Server Admin.

**Users See Error Messages While Streaming Media**

Here’s what the messages mean:

*Error code 401*: The user has tried to access a protected file. Users may need to upgrade to QuickTime 5 or later.

*Error code 404*: The server cannot locate the URL the user entered. Make sure users enter the correct URL for the broadcast. Tell users not to attempt to view media in a web browser by typing an RTSP URL directly into the web browser’s location address. RTSP URLs are used only with the Open URL command of QuickTime Player.

*Error code 415*: The movie file is not hinted or has a compressed movie resource. You need to hint the movie again using the Pro version of QuickTime Player. Alternatively, you may be attempting to natively serve MP3 files on demand (that is, as an HTTP download). QTSS support of MP3 streams is intended for Shoutcast/Icecast-compatible live streams (such as those created by an MP3 playlist) or live streams of other compatible MP3 live encoder broadcasters. If you wish to serve individual MP3 files on demand (not as live streams), simply host the files on a web server.
Chapter 5  Troubleshooting and Technical Information

**Error code 453:** The server is too busy for users to view the stream. Users should try again later. You may want to increase the maximum number of connections in the General Settings pane of Streaming Server Admin.

**Error code 454:** The connection to the server was dropped. Users must start viewing the stream again. Check if the server is behind a firewall or the client is behind Network Address Translation (NAT) software. See “Serving Streams Past Firewalls Using Port 80” on page 34 and “Streaming Past Firewalls or Networks With Address Translation” on page 34.

**Error code –5420:** The server may not be running. Check the streaming server and restart it if necessary. Check if the server is behind a firewall or the client is behind Network Address Translation (NAT) software. See “Serving Streams Past Firewalls Using Port 80” on page 34 and “Streaming Past Firewalls or Networks With Address Translation” on page 34.

**Users Want to Back Up Databases that QTSS Publisher Maintains**

It is important to understand the inner workings of QuickTime Streaming Server Publisher in order to be able to create an effective backup with or without a backup of published media.

Any media added to the main Library in QTSS Publisher goes directly into the “/Libraries” folder under “/Library/Application Support/Apple/QTSS Publisher”, also called the “QTSS Publisher folder”. The Libraries folder is a mirror image of the “Source Library” in the main view of QTSS Publisher, where all content is displayed.

When QuickTime media is published by QTSS Publisher via Fast Start, it becomes immediately available for download and is copied into the folder “qtmedia” under the default web server folder. The default Webserver folder is “/Library/Webserver/Documents” which can be modified in Server Admin. The “qtmedia” folder is designated by default as the “Media directory” and can be modified from the Settings > General tab in QuickTime Streaming in Server Admin.

Any content set for Instant-On, which is available through QuickTime Streaming Server for on-demand streaming, is copied into the “Movies” folder in the “/Library/QuicktimeStreaming”, also called the “QuickTimeStreaming folder”. QTSS Publisher also publishes Instant-On files to a “qtmedia” subfolder inside the /Library/QuickTimeStreaming/Movies folder.
QTSS Publisher maintains a concurrent database of all the content it is hosting in property list, or “plist”, files. The primary and most important of these is the “Links.plist” file located in the QTSS Publisher folder. This file gets created when you publish your first playlist or media file. The Web Pages.plist gets generated the first time you publish a webpage to the web server in QTSS Publisher. These files keep track of all information including which files have links. Any time you check a box in QTSS Publisher, an entry is added to the plist file.

All media gets entries in these plist files: a playlist, a movie file, an MP3 file, whether available for streaming or on demand. The information about everything that QTSS Publisher makes publicly available is recorded in these two files. Any playlists created by QTSS Publisher go into the /Library/Application Support/Apple/QTSS Publisher/Playlists folder.

Any webpages you create in QTSS Publisher populate the Media directory and a corresponding entry is stored in the “Web Pages.plist” which is discussed below.

A thumbnail image can be assigned to any movie (also called a Poster Image) for display on a webpage. The thumbnail resides on the default web server folder with the same name as the media file, appended with an “_i” at the end of the file name. When you upload a poster image (Thumbnail), an entry goes into Poster Images.plist.

When files are available for download (via Fast Start), the media file is copied into the default web server folder. If we specify a Fast Start file to also publish via the streaming server, the first thing QTSS Publisher does for Fast Start movies is create a copy of the movie that is optimized for fast-start and they get placed in the web server folder. Instant-On movies get an alias to the original file placed in the QuickTimeStreaming folder.

You can’t embed a streaming URL in a webpage directly, so you have to make a reference movie using QuickTime. This is a small file with a .mov extension which essentially redirects the QuickTime player to the streaming (RTSP) URL. The reference movie is created by QuickTime and is placed in qtmedia, (unless the default value has been modified,) under the web server location (/Library/Webserver/Documents).

Playlists are setup for broadcast only, not for on-demand usage. Media is hosted from the QTSS Publisher folder under Playlists. Every time you create a playlist, a subfolder is created in the Playlists folder. These playlists are stored in .playlist files in the individual subfolders of each playlist, which contain the names of all the files that are in the playlist. There is also a .config file for details which are stored in the standard file format documented at the Darwin Streaming Server site at developer.apple.com/darwin/projects/streaming/.
Webpages can be made on a number of different templates. When a webpage is created, a plist file gets added to the QTSS Publisher/Templates folder, called “Web Pages.plist”. This plist file stores information of all QTSS Publisher webpages.

The total set of files you need to back up our QTSS Publisher playlists (the entire “database”) is:
- /Library/Application Support/Apple/QTSS Publisher/Links.plist
- /Library/Application Support/Apple/QTSS Publisher/Web Pages.plist
- /Library/Application Support/Apple/QTSS Publisher/Playlists (where all the playlist and config files for individual playlists are stored)

Media is stored in the following locations, and a backup of the contents of the following folders would constitute comprehensive backup of published data:
- /Library/Application Support/Apple/QTSS Publisher
- /Library/QuickTimeStreaming/Movies/qtmedia
- /Library/Webserver/Documents/qtmedia

This folder contains thumbnails and Fast-Start media which are available for download. This location, called the default Media directory, can be modified in Server Admin.
This chapter describes the key components needed for a generic webcasting setup and how they are connected together.

The setup instructions that follow assume an educational setting, such as a university campus. But the example can be easily adapted for many uses including:

- Distance learning classes
- Corporate communications to employees, customers, suppliers, or shareholders
- One-time concert or presentation
- Childcare center broadcasts to parents

Streaming Presentations—Live and On Demand
This example shows how a university network administrator might set up a streaming server and other needed components to stream both live and on-demand classroom presentations to students using client computers connected to the campus network and to the Internet.
Such a setup would make it possible for students who couldn’t attend a class in person to view it online. It would also enable students to review parts of the lecture later by playing an archived version on their computers.

The streaming setup in this example, shown above, has these features:

- An already-existing local network with Ethernet connections to classrooms and lecture halls from which live presentations are to be streamed.
- A digital video (DV) camera and microphone set up in a classroom or lecture hall to convert the live presentation to digital form. The camera makes a high-quality DV recording of the presentation and provides the digital signal to be encoded for live streaming.
- The DV camera is connected through a FireWire port to a laptop computer running QuickTime Broadcaster, which encodes the digitized live presentation and transmits the signal via an Ethernet connection to the streaming server on the campus network.
- The streaming server is a rack-mounted Xserve running “headless” (without a monitor and keyboard). The server is running Mac OS X Server with QuickTime Streaming Server (QTSS) configured to reflect the encoded live presentation as a unicast stream to each client computer—on the campus network or on the Internet—that “tunes in” to the broadcast. The Xserve comes with Mac OS X Server and QTSS preinstalled.
• Client computers of various types with QuickTime Player or other MPEG-4 compliant software installed can access the Xserve streaming server via the campus network. Other client computers can access the streaming server via the Internet.
• The broadcaster laptop running iMovie is used to produce high-quality on-demand versions of a live presentation after the presentation is concluded. The recorded digitized presentation is brought into the computer for compression through its FireWire connection using the DV camera.

  *Note:* QuickTime Broadcaster can be set to record the encoded live stream to disk for archival purposes. For best results, however, the footage should be encoded separately.

• The broadcaster laptop is also used to control the Xserve remotely using the Server Admin application (or using Web Admin, the QTSS web-based administration application).

  *Note:* The laptop could also be connected to the local network wirelessly via an AirPort base station for extra portability. The AirPort is 802.11 compliant and works fine with QTSS. Its 11 megabits per second (Mbps) of bandwidth is more than enough for our example setup if other clients don't place heavy demands on the same base station.

### Setting It Up

The following steps show how to set up QuickTime Streaming Server and the other components needed for live and on-demand streaming in this hypothetical university setting.

**Step 1: Prepare the Location**

A typical classroom doesn't provide a broadcasting and recording environment comparable to a professional television or recording studio. The following measures can help ensure reasonably good results:

• Go into the classroom or lecture room you want to use for live streaming, close the doors, and listen for extraneous noise that could interfere with a broadcast. If noise from a nearby break room, video gaming area, street traffic, or other source is noticeable and can't be eliminated, find another room.

• If extraneous noise is not an issue, stand in the center of the room, clap your hands or shout, and listen for an echo. If you hear an echo, the sound quality of a live broadcast can be compromised. You can reduce or eliminate echoes by hanging heavy curtains on bare walls or placing acoustic panels in a checkerboard pattern on each wall.

• Next, examine the floors and furniture. Carpeted floors and padded chairs are best. A lectern should have a cloth on top or other padded surface to protect against noises such as the speaker setting down a glass of water.
• Windows can cause lighting problems. For more control, you should be able to draw the blinds and supplement room lights with a portable lighting kit that can be quickly set up for a live session.

**Step 2: Prepare the Network**

Check that there is an Ethernet connection to the room where the live broadcast is to take place. Install, repair, or replace cables and connectors as needed, using high-quality materials.

Bear in mind that streaming—especially live streaming—can make heavy demands on network resources, especially available bandwidth. To ensure that the network can handle the extra load, it may be necessary to do some or all of the following:

• Determine the capacity of the existing network and calculate the anticipated additional traffic generated by live and on-demand streaming.

• Draw a map of bandwidth segments on your network, listing the capacity between all points.

• Determine which applications are used in your network, their use patterns, where they are hosted, and the bandwidth they normally use during peak and off-peak times.

• Based on the configuration and capacities of your network, select the appropriate place to install your streaming server, avoiding potential bottlenecks.

• If necessary, add capacity to the network (additional T1 lines, routers, switches, and so on) to handle the anticipated maximum number of concurrent viewers of live broadcasts in addition to other peak network traffic.

*Note:* A typical local network provides bandwidth internally of 10–100 Mbps. In contrast, a T1 line provides only about 1.5 Mbps of bandwidth.

T1 lines work fine for HTTP and FTP, where the requests are either short-lived or are not time sensitive, but streaming is much more demanding. With streaming you can't slow things down—the data has to be transferred at least as fast as the original content data rate in order to deliver streams.

For this example, we will assume a maximum of 10 concurrent viewers, half on the local network and half on the Internet, and a bit rate for each unicast stream of approximately 256 kilobits per second (Kbps). The peak extra bandwidth needed is then about 3.2–3.3 megabits per second (Mbps). This estimate includes an extra margin of 25–30 percent for unplanned network congestion and peaks in the transmitted streams that can occur for various reasons.

**Step 3: Set Up Your Streaming Server**

An administrator computer must be set up before you can configure and manage your streaming server if, as in this example, the streaming server is running headless. For information on setting up an administrator computer, see *Mac OS X Server Getting Started for Version 10.4 or Later* (included on a Mac OS X Server install disc).
To set up and manage QTSS, you use the Server Admin application, which is installed with Mac OS X Server (version 10.4 or later). After configuring Mac OS X Server, you can also use the web-based administration application, Web Admin, to manage QTSS remotely from any computer connected directly to the local network or to the Internet. For this example, we assume that the broadcaster laptop in the streaming setup illustration is also used for this purpose.

Although the Xserve comes with Mac OS X Server and QTSS preinstalled, the software must be configured for the particular network to which it is being added and for the specific uses to which it is to be put. For information on setting up Mac OS X Server, see the getting started guide.

Among the questions to be answered when setting up your streaming server are the following:

**Can the server computer be dedicated solely to streaming?**
It’s best if your streaming server doesn’t also have to handle web serving, mail serving, and other server tasks. This example is for a dedicated streaming server.

**How much random access memory (RAM) is needed?**
The minimum required to run QTSS is 128 megabytes (MB). Estimate about 256 MB of RAM for every 50 MB of throughput you plan to serve. This setup assumes 256 MB of RAM.

**How much hard disk storage is needed?**
Video files can be large. A hinted one-hour presentation encoded at 300 Kbps (not optimized for a server) takes up approximately 135 MB of hard disk space. A 60 GB hard disk can store more than 400 such presentations.

*Note:* Here’s a formula for calculating streaming file sizes:

\[
\text{dataRateInBits} / 8 \text{ bits} \times \text{timeInSeconds} = \text{file size}
\]

Example for a one-hour 300-Kbps stream:

\[
300,000 / 8 \text{ bits} \times 3600 = 135,000,000 \text{ bytes} = 135 \text{ MB file size}
\]

Many local networks include redundant arrays of independent disks (RAID) storage systems, which provide much larger amounts of hard disk space.

If you store streaming files anywhere other than the QTSS default location (/Library/QuickTimeStreaming/Movies), you’ll need to enter the path in the Settings pane of QuickTime Streaming in Server Admin (see “Changing the Streaming Media Directory” on page 30). Place any Session Description Protocol (SDP) files referencing live webcasts in the same location so they can be recognized by QTSS.

In this example, all archived streaming files and SDP reference files reside in the default Movies folder on the streaming server.
Does the streaming server have an adequate network card?
The network card is a critical component of your streaming server, since it provides Ethernet connectivity between the server and your audience. An Ethernet card should provide a minimum of 100 megabytes (about 0.1 gigabit) per second of throughput.

Where will the streaming server be located on the network? What about a firewall?
The streaming server must be located where it will be accessible to users (in our example, students) logging in from both the local network and the Internet. It also should be protected by a firewall against unauthorized access to the server and to archived media files.

Mac OS X Server includes IP Firewall service, which scans incoming IP packets and rejects or accepts these packets based on a set of filters you create. For instructions on setting up this service, see the network services administration guide.

Specific ports need to be opened in the firewall to allow Real-Time Streaming Protocol (RTSP) requests from users, encoded video and audio from the broadcaster, and outbound streams to clients on the local network and the Internet. The table below lists the ports used by QuickTime Streaming Server and for incoming and outgoing requests. (For more information about enabling QuickTime Streaming over a firewall, see “Security and Access” on page 33.)

<table>
<thead>
<tr>
<th>Usage</th>
<th>Ports</th>
<th>Protocols</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Responding to messages from clients</td>
<td>TCP (client initiates -&gt; QTSS): 554, 7070, 8000, 8001, 80</td>
<td>RTSP, RTP, RTCP, MP3</td>
<td>Main port is 554, 80 is supported in the QT client as an alternative TCP port. These ports also send data to clients.</td>
</tr>
<tr>
<td>(such as Play and Pause)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sending media and receiving client status</td>
<td>• UDP data (QTSS -&gt; client): 6970–6999, even numbers</td>
<td>RTP</td>
<td>Status is required to maintain a connection; if blocked, the server disconnects the client.</td>
</tr>
<tr>
<td></td>
<td>• UDP status (QTSS &lt;-&gt; client): 6971–6999, odd numbers</td>
<td>RTCP</td>
<td>Same ports used to respond to messages.</td>
</tr>
<tr>
<td></td>
<td>• TCP data &amp; status (QTSS &lt;-&gt; client): 554, 7070, 8000, 8001, 80</td>
<td>RTSP, RTP, RTCP</td>
<td></td>
</tr>
<tr>
<td>Receiving broadcasts</td>
<td>• UDP data (broadcaster -&gt; QTSS): 6972–65535, even numbers</td>
<td>RTP</td>
<td>• Ports depend on the broadcaster configuration.</td>
</tr>
<tr>
<td></td>
<td>• UDP RTCP status (broadcaster &lt;-&gt; QTSS): 6973–65535, odd numbers</td>
<td>RTCP</td>
<td>• Status is required to maintain a connection; if blocked, the server disconnects the broadcaster.</td>
</tr>
<tr>
<td></td>
<td>• TCP (broadcaster initiates -&gt; QTSS): 554, 7070, 8000, 8001, 80</td>
<td>RTSP, RTP, RTCP</td>
<td>• Broadcasters can broadcast over their TCP message connection with the server instead of using UDP ports.</td>
</tr>
<tr>
<td>Streaming through server</td>
<td>TCP (client initiates -&gt; QTSS): 554, 7070, 8000, 8001, 80</td>
<td>RTSP, RTP, RTCP, MP3</td>
<td>Same ports used to respond to messages and receive TCP broadcasts.</td>
</tr>
</tbody>
</table>
In this setup example, we'll assume that the students connecting to the streaming server via the Internet are not behind their own firewalls. In that case, we won't enable streaming on port 80, the port typically carrying HTTP Internet traffic and allowed by most firewalls.

If some clients are behind firewalls, it may be desirable to enable streaming on port 80 for those clients to access the streams. For instructions, see “Serving Streams Past Firewalls Using Port 80” on page 34.

Will it be necessary to set up a broadcaster user account on the streaming server?
In this setup example, it’s necessary to create a broadcaster user name and password because the encoding software and QTSS are on separate computers. Creating a broadcaster user allows a Session Description Protocol (SDP) file, which provides information about the format, timing, and authorship of a live streaming broadcast, to be created on the server. Once specified, the user name and password are entered through QuickTime Broadcaster.

For instructions on creating or changing a broadcaster user name and password, see “Using Automatic Unicast (Announce) With QTSS on a Separate Computer” on page 35. You’ll need to use the administrator computer previously set up.

Will users require authentication to access live or archived presentations?
In our example setup, no authentication is necessary. However, if you want to restrict access to your streams, you'll need to set up individual or group streaming user names and passwords. For information on how to set up and manage such accounts, see the appropriate topics under “Security and Access” on page 33.

Step 4: Set Up for a Live Webcast
For the example setup, the following items are needed:
• Good-quality DV camera
• Microphone placed near the speaker, either on a stand or clipped to the speaker’s clothing, connected by good-quality audio cable to the DV camera audio input
• Sturdy tripod on which to mount the camera
• Portable lighting kit
The Camera Is the First Link
Since the camera is the first link in the video signal chain, it is very important. Two main things determine a DV camera’s picture quality:

- **Lens quality.** The better the lens, the better the image.
- **Image capture mechanism.** DV cameras use charge-coupled devices (CCDs) to convert the picture into electronic signals. The number and size of the CCDs affect the quality of the image.

Optical zoom gives better quality than digital zoom, but zooming should be avoided or kept to a minimum when streaming a live presentation to avoid degrading the stream.

Lower-end DV cameras use a single charge-coupled device (CCD) to capture the complete image, whereas higher-quality cameras use three separate CCDs to scan the red, blue, and green content of the image, giving a better quality scan. CCDs range in size from 1/4 inch to 2/3 inch; bigger CCDs give better resolution.

Here are other desirable features:

- You should be able to override automatic camera settings.
- You’ll want to use a separate microphone that can plug in to the camera for optimal sound pick-up. A built-in microphone is unsuitable for most situations.
- The camera should accept professional XLR plugs (as opposed to the 1/8-inch mini-jack connectors). It should also have a headphone jack for monitoring the audio input.
- Finally, a FireWire output enables digital transfers and automated capture, which can save time later.

Keep the Microphone Close
The microphone is the first link in the audio signal chain and so is also very important. Dynamic microphones are a good all-around choice and can be purchased for as little as $100.

The best way to improve audio if the room has bad acoustics is to place the microphone as close as possible to the person doing the speaking. Use a small lavalier (lapel) microphone clipped to the front of the speaker’s clothing immediately under the mouth, or use a handheld microphone.

In the case of a panel discussion, use multiple microphones, preferably on sturdy stands, and a small audio mixer. Connect the mixed stereo output from the mixer into the line input on the DV camera.

If using an external microphone or mixer, make sure that all the connectors are securely plugged in to assure reliable audio. Plug a pair of headphones into the video camera’s headphone output to make sure that you can hear the audio and that it’s not distorted.
A Tripod Is a Must
It’s important to use a camera tripod when shooting a live presentation, and also to avoid pans, tilts, and zooms. If the camera moves just one degree, every pixel in the frame changes, multiplying the difficulty of encoding the stream adequately. What was a simple scene to encode suddenly becomes much more difficult.

The tripod should be lightweight while still providing stable support for the camera’s weight.

Get a Simple Lighting Kit
Lighting is a big subject and beyond the scope of this guide, but here are some brief suggestions.

Even a high-quality video camera will produce poor results without proper lighting. It’s unlikely that the normal lighting available in a typical classroom will be adequate for shooting a live presentation. At a minimum, you’ll probably want to add backlighting to make your subject stand out from the background. A portable lighting kit supporting three-point lighting, plus a reflector or two if you’re planning to shoot outside, can greatly improve your results.

Step 5: Set Up Broadcaster
In this example, QuickTime Broadcaster is installed on a laptop computer. This encoding software is included on the Mac OS X Server CD and can also be downloaded free of charge from the QuickTime Broadcaster website at www.apple.com/quicktime/products/broadcaster/.

To install QuickTime Broadcaster, double-click the installer package (QuickTimeBroadcaster.pkg) and follow the on-screen instructions.

Once the encoder software is installed, plug the camera into the laptop using FireWire, turn the camera on, and see if QuickTime Broadcaster recognizes it.

1 Open QuickTime Broadcaster and click Show Details.
2 Click Video and choose a video source from the Source pop-up menu.
   If the camera is recognized, it appears in the Source menu. Video settings should also be active (not dimmed).
   If the camera doesn’t appear in the Source menu, quit QuickTime Broadcaster, make sure your camera is connected and turned on, and then open QuickTime Broadcaster again. If your camera still does not appear, check the QuickTime website or the AppleCare Service & Support website for information on compatibility and other issues.

When broadcasting to QTSS on a separate computer, as in this example, Automatic Unicast (Announce) is the recommended transmission method. It’s easy to set up.

1 In QuickTime Broadcaster, click Show Details, click Network, and choose Automatic Unicast (Announce) from the Transmission pop-up menu.
2 In the Network pane, enter the IP address or host name of the receiving server (the Xserve in this example), a name for the broadcast file, the user name and password for the broadcaster user created in Step 3, and the buffer delay (or accept the default).

**Note:** The buffer delay sets the number of seconds QuickTime buffers the broadcast before playback. For broadband connections, QuickTime Player 6 or later fills the buffer more quickly than real time, providing an “Instant-On” viewing experience.

3 Click Broadcast and start QTSS (if it’s not already running) by selecting the computer in Server Admin, clicking QuickTime Streaming, and clicking Start Service.

To find out if the live stream can be seen from a client, open QuickTime Player on one of the client computers and do the following:

1 Choose File > Open URL in New Player.

2 Enter the Real-Time Streaming Protocol (RTSP) URL displayed in the Location section of the QuickTime Broadcaster window (for example, rtsp://myserver.com/mystream.sdp).

**Note:** The URL is case-sensitive and must be entered exactly as displayed in the QuickTime Broadcaster window.

The live stream should start playing in QuickTime Player.

**Step 6: Test Your Setup**
The last step is to test the setup. This should be done as realistically as possible.

- Set up your equipment just as it will be used for the live presentation—in the actual location, if possible.
- Ask a colleague to stand in for the presenter, or better yet, have the presenter take part in the test, making it a “dress rehearsal.”
- Check the video image and the sound.
- Check that clients both on the local network and on the Internet can tune in to the live stream.
- Adjust the camera and microphone positions and lighting as necessary and troubleshoot any other problems.

**Creating a Webpage for Easy Access**
Enabling access from a webpage eliminates students’ having to remember the RTSP URL and names of the streaming server and SDP files.

In our example, the webpage can be added to the existing university website, but it can reside on any web server. Students can access the live presentation (as well as the archives) by clicking links in their browser.

For instructions on creating a webpage with links to streamed media, see “Creating Webpages” on page 48, which is regarding QTSS Publisher and Video On Demand.
QTSS Publisher will not work for creating webpages with Live Streams from QuickTime Broadcaster. To create a link to the live stream on a webpage, you have to embed a streaming movie. One way to embed a streaming movie is with a reference movie.

There are a variety of ways to create reference movies, which function like pointers to the actual media. The simplest way to create a reference movie is with QuickTime Pro:

1. Open QuickTime Player Pro
2. From the File menu select “Open URL…”
3. Open the URL to your streaming movie using the rtsp URL.
4. Save the movie that plays as a Self-Contained movie.
5. Put the movie that you saved on your website.
6. Make the reference movie the first attribute you specify in the QT WriteObject method call.

If you don’t have QuickTime Pro, you can create a simple reference movie with any text editor. Just create a text file with one line in the following format:

RTSPtextRTSP://<your server>/<your streaming movie>

Save the file with the .mov extension and place the file on your web server. To embed the movie on a webpage, use the Object/Embed tag in the webpage’s HTML. For example, if the reference movie was named “live.mov” and is in the same directory as the HTML page, the following tag would embed the live stream:

```html
<OBJECT CLASSID="clsid:02BF25D5-8C17-4B23-BC80-D3488ABDDC6B"
    WIDTH="320" HEIGHT="256" CODEBASE="http://www.apple.com/qtactivex/qtplugin.cab">
    <PARAM NAME="src" VALUE="live.mov">
    <PARAM NAME="autoplay" VALUE="true">
    <EMBED SRC="live.mov" WIDTH="320" HEIGHT="256" PLUGINSPAGE="http://www.apple.com/quicktime/" AUTOPLAY="true" />
</OBJECT>
```

There are many resources with information about authoring webpages with QuickTime content. Some excellent references include:

*Quicktime for the Web*, by Steven Gulie, is the definitive book on QuickTime web authoring with QuickTime Pro keys included.

Apple’s website documents the attributes of the Object/Embed tag:

www.apple.com/quicktime/authoring/embed.html
Shooting the Live Presentation

If all the preparatory work has been done as outlined above, and the equipment and connections have been thoroughly tested, shooting the live presentation should be straightforward.

Here are a few tips for avoiding problems during the event:

• On the day of the actual event to be streamed live, set up early so you have time to check once again that all components are working as expected.
• If an audience is to be present, let them know in advance that you will be webcasting the presentation live and ask for their cooperation.
• Tape down any cables along the floor to minimize tripping hazards.
• Use a directional microphone or a live audio feed if at all possible.
• Check for potential sources of extraneous noise and take abatement measures if possible.

Archiving the Live Presentation

In the example setup, the iMovie application, which comes with Mac OS X, is on the laptop. iMovie is used to import the recorded DV footage from the camera tape and then to encode and archive taped live presentations.

To archive a live presentation, first import the recorded DV footage:

1. Connect the DV camera to the laptop using FireWire and turn on the camera.
2. Insert the tape with the video footage to be archived and switch to VTR mode.
3. On the laptop, open iMovie and set the Mode Switch under the iMovie monitor to Camera mode (drag the round blue slider toward the DV camera icon).
4. Use the playback controls to view a portion of the tape in the iMovie monitor. If the tape doesn’t play, check the connections and make sure the camera is turned on.
5. Rewind the tape to a few seconds before the point where you want to start importing.
6. Click Play below the iMovie monitor.
7. Click Import when you see the point in the presentation where you want to start importing.
8. Click Import again when you want to stop importing.
9. If you get some footage that you don’t want to include in your archived presentation, you can edit it later using iMovie.

Important: You’ll need to monitor hard disk space as you import video and create your iMovie. One minute of DV footage uses about 220 MB of hard disk space, so a one-hour presentation can use up more than 13 gigabytes of disk space. The Free Space status bar, below the clip shelf, shows how much disk space is available at any point in the import process.
Next, use iMovie to compress and encode the DV footage for streaming:

1. In iMovie, choose File > Export Movie.
2. Choose To QuickTime from the Export Movie pop-up menu.
3. Choose a movie format from the Formats pop-up menu.
   You can choose one of the QuickTime formats optimized for different uses or choose Expert, which provides custom QuickTime settings such as MPEG-4 Video.
4. Click Export.
5. Name your movie, select a destination for the file, and click Save.
   The time it takes to save the movie depends on the movie’s length and the format you chose.
   **Note:** You may want to save more than one archive streaming file, each compressed for a different connection speed. For example, you might choose lower compression settings for clients on the campus network and higher compression settings for clients connecting over the Internet.
6. After you have saved the encoded file or files, check to make sure every file streams properly.
access file  A text file called qtaccess that contains information about users and groups who are authorized to view media in the directory in which the access file is stored.

administrator  A user with server or directory domain administration privileges. Administrators are always members of the predefined “admin” group.

administrator computer  A Mac OS X computer onto which you’ve installed the server administration applications from the Mac OS X Server Admin CD.

announced broadcast  A method such as Automatic Unicast (Announce) that enables a broadcaster to negotiate with a server to accept a broadcast.

AppleScript  A scripting language with English-like syntax, used to write script files that can control your computer. AppleScript is part of the Mac operating system and is included on every Macintosh.

Automatic Unicast (Announce)  A method of delivering a broadcast to a streaming server in which an SDP file is automatically copied and kept current on the server. A broadcast user name and password must be created before starting such a broadcast.

AVI  Audio Visual Interleave. A Windows video file format.

bandwidth  The capacity of a network connection, measured in bits or bytes per second, for carrying data.

bit  A single piece of information, with a value of either 0 or 1.

bit rate  The speed at which bits are transmitted over a network, usually expressed in bits per second.

broadcast  In a general networking context, the transmission of a message or data that any client on the network can read. Broadcast can be contrasted with unicast (sending a message to a specific computer) and multicast (sending a message to a select subset of computers). In QuickTime Streaming Server, the process of transmitting one copy of a stream over the whole network.
**broadcast user**  A user who has permission to broadcast to the streaming server. The broadcast user name and password are set in the General Settings pane of Streaming Server Admin and are used in conjunction with announced broadcasts. It isn’t necessary to create a broadcast user for UDP broadcasts.

**browser plug-in**  Software that you attach to a browser to enable it to display specific data formats.

**byte**  A basic unit of measure for data, equal to eight bits (or binary digits).

**client**  A computer (or a user of the computer) that requests data or services from another computer, or server.

**codec**  Any technology for compressing and decompressing data. Codecs can be implemented in software, hardware, or a combination of both.

**data rate**  The amount of information transmitted per second.

**DNS**  Domain Name System. A distributed database that maps IP addresses to domain names. A DNS server, also known as a name server, keeps a list of names and the IP addresses associated with each name.

**DSL**  Digital subscriber line. A broadband data transmission technology that operates over telephone lines.

**DV**  Digital video. A digital tape-recording format using approximately 5:1 compression to produce Betacam quality on a very small cassette.

**firewall**  Software that protects the network applications running on your server. IP firewall service, which is part of Mac OS X Server software, scans incoming IP packets and rejects or accepts these packets based on a set of filters you create.

**FireWire**  A hardware technology for exchanging data with peripheral devices, defined by IEEE Standard 1394.

**frame**  In QuickTime streaming, a single image in a movie or sequence of images.

**frame rate**  In a movie, the number of frames per second.

**FTP**  File Transfer Protocol. A protocol that allows computers to transfer files over a network. FTP clients using any operating system that supports FTP can connect to a file server and download files, depending on their access privileges. Most Internet browsers and a number of freeware applications can be used to access an FTP server.
hinting  A process that creates a track for each streamable media track in the file that tells QuickTime Streaming Server how and when to deliver each frame of media. The hinting process performs the required calculations in advance, allowing QTSS to serve up a larger number of streams. Hinting also allows new codecs to be used without the need to upgrade the server.

HTML  Hypertext Markup Language. The set of symbols or codes inserted in a file to be displayed on a World Wide Web browser page. The markup tells the web browser how to display a webpage’s words and images for the user.

HTTP  Hypertext Transfer Protocol. The client/server protocol for the World Wide Web. The HTTP protocol provides a way for a web browser to access a web server and request hypermedia documents created using HTML.

IEEE  Institute of Electrical and Electronics Engineers, Inc. An organization dedicated to promoting standards in computing and electrical engineering.

Instant On  In QuickTime streaming, an advance in Apple’s patent-pending Skip Protection technology that dramatically reduces buffer, or wait, time for an instantaneous viewing experience with streaming video on a broadband connection.

IP  Internet Protocol. Also known as IPv4. A method used with Transmission Control Protocol (TCP) to send data between computers over a local network or the Internet. IP delivers packets of data, while TCP keeps track of data packets.

IP address  A unique numeric address that identifies a computer on the Internet.

IP subnet  A portion of an IP network, which may be a physically independent network segment, that shares a network address with other portions of the network and is identified by a subnet number.

ISP  Internet service provider. A business that sells Internet access and often provides web hosting for ecommerce applications as well as mail services.

JavaScript  A scripting language used to add interactivity to webpages.

key frame  A sample in a sequence of temporally compressed samples that doesn’t rely on other samples in the sequence for any of its information. Key frames are placed into temporally compressed sequences at a frequency that’s determined by the key frame rate.

key frame rate  The frequency with which key frames are placed into temporally compressed data sequences.

LAN  Local area network. A network maintained within a facility, as opposed to a WAN (wide area network) that links geographically separated facilities.
layer  A mechanism for prioritizing the tracks in a movie or the overlapping of sprites. When QuickTime plays a movie, it displays the movie’s images according to their layer-images with lower layer numbers are displayed on top; images with higher layer numbers may be obscured by images with lower layer numbers.

M3U file  An audio metafile that’s created using a text editor and saved to a web server. The file directs a user’s web browser to an MP3 playlist residing on the same web server and opens the user’s MP3 player.

Mac OS X  The latest version of the Apple operating system. Mac OS X combines the reliability of UNIX with the ease of use of Macintosh.

Mac OS X Server  An industrial-strength server platform that supports Mac, Windows, UNIX, and Linux clients out of the box and provides a suite of scalable workgroup and network services plus advanced remote management tools.

Manual Unicast  A method for transmitting a live stream to a single QuickTime Player client or to a computer running QTSS. An SDP file is usually created by the broadcaster application and then must be manually sent to the viewer or streaming server.

MBONE  Multicast backbone. A virtual network that supports IP multicasting. An MBONE network uses the same physical media as the Internet, but is designed to repackage multicast data packets so they appear to be unicast data packets.


modifier track  A track in a movie that modifies the data or presentation of other tracks. For example, a “tween” track is a modifier track.

mount point  In streaming, a string used to identify a live stream, which can be a relayed movie stream, a nonrelayed movie stream, or an MP3 stream. Mount points that describe live movie streams always end with a .sdp extension.

mov  The Apple QuickTime movie file extension used to name both movie redirect files and actual QuickTime media files.

movie  A structure of time-based data that’s managed by QuickTime. A QuickTime movie may contain sound, video, animation, or a combination of data types. A QuickTime movie contains one or more tracks; each track represents a single data stream in the movie.

MP3  MPEG layer 3. A popular format for compressing music.

MPEG-4  An ISO standard based on the QuickTime file format that defines multimedia file and compression formats.
**multicast**  In general, the simultaneous transmission of a message to a specific subset of computers on a network. See also **broadcast**, **unicast**. In QuickTime streaming, an efficient, one-to-many form of streaming. Users can join or leave a multicast but cannot otherwise interact with it.

**multihoming**  The ability to support multiple network connections. When more than one connection is available, Mac OS X selects the best connection according to the order specified in Network preferences.

**NAT**  Network Address Translation. A method of connecting multiple computers to the Internet (or any other IP network) using one IP address. NAT converts the IP addresses you assign to computers on your private, internal network into one legitimate IP address for Internet communications.

**open source**  A term for the cooperative development of software by the Internet community. The basic principle is to involve as many people as possible in writing and debugging code by publishing the source code and encouraging the formation of a large community of developers who will submit modifications and enhancements.

**packet**  A unit of data information consisting of header, information, error detection, and trailer records. QTSS uses TCP, UDP, and IP packets to communicate with streaming clients.

**pixel**  A single dot in a graphic image with a given color and brightness value.

**playlist**  A set of media files in the QTSS media folder specified to play one after the other or in random sequence.

**port**  A sort of virtual mail slot. A server uses port numbers to determine which application should receive data packets. Firewalls use port numbers to determine whether data packets are allowed to traverse a local network. “Port” usually refers to either a TCP or UDP port.

**privileges**  The right to access restricted areas of a system or perform certain tasks (such as management tasks) in the system.

**progressive download**  Movie data that’s pushed via HTTP to the client. The movie can be viewed by the user as it is being transferred. This isn’t a form of media streaming.

**protocol**  A set of rules that determines how data is sent back and forth between two applications.

**proxy server**  A server that sits between a client application, such as a web browser, and a real server. The proxy server intercepts all requests to the real server to see if it can fulfill the requests itself. If not, it forwards the request to the real server.
QTSS  QuickTime Streaming Server. A technology that lets you deliver media over the Internet in real time.

QTSS Publisher  An Apple application (included with Mac OS X Server version 10.3 and later) for managing QuickTime media and playlists, and preparing media for streaming and downloading.

QuickTime  A set of Macintosh system extensions or a Windows dynamic-link library that supports the composition and playing of movies.

QuickTime Player  An application, included with the QuickTime system software, that plays QuickTime movies.

QuickTime Pro  A version of QuickTime Player with advanced features, primarily the addition of editing capabilities.

RAID  Redundant Array of Independent (or Inexpensive) Disks. A grouping of multiple physical hard disks into a disk array, which either provides high-speed access to stored data, mirrors the data so that it can be rebuilt in case of disk failure, or both of these features. The RAID array is presented to the storage system as a single logical storage unit. See also RAID array, RAID level.

reference movie  A .mov file created using a utility program like MakeRefMovie, available at no cost from Apple for Macintosh and Windows. The file contains the location of a streaming media file and can also contain the locations of multiple streaming files. A reference file linked from a webpage, for example, can direct a client player to the on-demand presentation encoded for its particular connection speed.

reflected stream  A live broadcast delivered as a unicast stream. Movie and MP4 playlists also generate reflected streams.

relay  In QuickTime Streaming Server, a relay receives an incoming stream and then forwards that stream to one or more streaming servers. Relays can reduce Internet bandwidth consumption and are useful for broadcasts with numerous viewers in different locations. In Internet mail terms, a relay is a mail SMTP server that sends incoming mail to another SMTP server, but not to its final destination.

relayed stream  A stream that’s passed from one server to one or more other servers. Relays can also be used to generate a multicast stream. QTSS doesn’t support relaying of MP3 streams.

RTP  Real-Time Transport Protocol. An end-to-end network-transport protocol suitable for applications transmitting real-time data (such as audio, video, or simulation data) over multicast or unicast network services.
RTSP  Real Time Streaming Protocol. An application-level protocol for controlling the delivery of data with real-time properties. RTSP provides an extensible framework to enable controlled, on-demand delivery of real-time data, such as audio and video. Sources of data can include both live data feeds and stored clips.

**sample rate**  The number of samples per second used for audio. Higher sample rates yield higher quality audio than lower sample rates.

SDP  Session Description Protocol. A text file used with QuickTime Streaming Server that provides information about the format, timing, and authorship of a live streaming broadcast and gives the user’s computer instructions for tuning in.

SMTP  Simple Mail Transfer Protocol. A protocol used to send and transfer mail. Its ability to queue incoming messages is limited, so SMTP usually is used only to send mail, and POP or IMAP is used to receive mail.

**sprite**  An animated image that’s managed by QuickTime. A sprite is defined once and is then animated by commands that change its position or appearance.

SSL  Secure Sockets Layer. An Internet protocol that allows you to send encrypted, authenticated information across the Internet. More recent versions of SSL are known as TLS (Transport Level Security).

**streaming**  Delivery of video or audio data over a network in real time, as a stream of packets instead of a single file download.

TCP  Transmission Control Protocol. A method used along with the Internet Protocol (IP) to send data in the form of message units between computers over the Internet. IP takes care of handling the actual delivery of the data, and TCP takes care of keeping track of the individual units of data (called packets) into which a message is divided for efficient routing through the Internet.

**temporal compression**  Image compression that’s performed between frames in a sequence. This compression technique takes advantage of redundancy between adjacent frames in a sequence to reduce the amount of data that’s required to accurately represent each frame in the sequence. Sequences that have been temporally compressed typically contain key frames at regular intervals.

**track**  A QuickTime data structure that represents a single data stream in a QuickTime movie. A movie may contain one or more tracks. Each track is independent of other tracks in the movie and represents its own data stream.

TTL  Time-to-live. The specified length of time that DNS information is stored in a cache. When a domain name-IP address pair has been cached longer than the TTL value, the entry is deleted from the name server’s cache (but not from the primary DNS server).
**tween track**  A track that modifies the display of other tracks.

**UDP**  User Datagram Protocol. A communications method that uses the Internet Protocol (IP) to send a data unit (called a datagram) from one computer to another in a network. Network applications that have very small data units to exchange may use UDP rather than TCP.

**unicast**  The transmission of data to a single recipient or client. If a movie is unicast to a user using RSTP, the user can move freely from point to point in an on-demand movie.

**URL**  Uniform Resource Locator. The address of a computer, file, or resource that can be accessed on a local network or the Internet. The URL is made up of the name of the protocol needed to access the resource, a domain name that identifies a specific computer on the Internet, and a hierarchical description of a file location on the computer.

**VBR**  Variable bit rate. A method of compressing data that takes advantage of changes in the media's data rate.

**wav**  A Windows format for sound files.

**webcast**  A broadcast of live video or audio on the Internet.

**XLR plug**  A three-pin audio connector that can be used with three-wire balanced cables, which cause electromagnetic interference to be canceled out.

**XML**  An extensible markup language, similar to HTML but more formal and more flexible.
Index

A
access control 35–38
access files 36–37
access history log 32
address translation 34
administering streaming servers. See Streaming
Server Admin application
administrators 36
AirPort base station 59
annotations 45
Announce (Automatic Unicast) 35, 65–66
any-user tag 37
Apache web server 7
Apple skip-protection technology 16
archiving live presentations 68–69
audio live 17
MP3 audio streaming 8
streaming 17
authentication access to streamed media 35–38, 63
basic 37
digest 35
disabling 36
features 8
overriding global setting 37
AuthScheme keyword 37
Automatic Unicast (Announce) 35, 65–66

B
bandwidth considerations 24
live streaming and 18, 60
networks and 60
bandwidth segments 60
basic authentication 37
broadband connections 16, 23
Broadcaster. See QuickTime Broadcaster
broadcaster user account 35, 63
broadcasting software 16
broadcasts connecting over HTTP 52
generic webcasting setup 57–69
live 24
playlists 42, 46
prerecorded media 42, 43
relayed 20
unable to connect to 52, 53
browsers. See web browsers

cable modems 24
cameras
DV. See DV camera
tripod 63, 65
CCDs (charge-coupled devices) 64
charge-coupled devices (CCDs) 64
client computers
access to streaming servers 59
media sent to 18
multicast vs. unicast transport 19
requirements for 23
viewing live streams 66
viewing streamed media 26
codes 42
computers client. See client computers
IP address of 31
source 31
connections broadband 16, 23
broadcast 52, 53
cable modem 24
data rates 24
dropped 53
DSL 24
Ethernet 60, 62
HTTP 34, 52
maximum number of 29, 51, 53
wireless 59

D
Darwin Streaming Server (DSS)
described 9
obtaining 7
QuickTime Broadcaster and 17
source code 14
support 14
version 4 8–9
version 4,1 8
data rates 24
deleting items
groups 38
users from user/group file 38
delivery, live 16
delivery, on-demand 16
digest authentication 35
Digital Subscriber Line (DSL) 24
disk space 61, 68
DNS hostname 31
documentation 11
DSL (Digital Subscriber Line) 24
DV camera
live webcasts 64–65
QuickTime Broadcaster and 65
streaming presentations 58
E
error 453 29
error code 401 37
error codes 52
errors
See also troubleshooting
listed 52–53
server busy 29
while streaming media 52–53
Ethernet cards 62
Ethernet connections 60, 62
events, live 16
exporting items
QuickTime movies as hinted movies 42
F
files
access 36–37
MP3 25, 52
MPEG-1 51
MPEG-4 8, 23
SDP. See SDP files
firewalls 34, 62
Firewire output 64
Firewire ports 58
Firewire technology 24
G
group file 38
groups 37, 38
H
hard disk space 61, 68
hardware requirements 24, 61–62
headphone jack 64
headphones 64
hinted movies 42
errors with 52
exporting QuickTime movies as 42
performance 44
hinted MPEG-1 files 51
hinting
MP3 files and 43
home directory
streaming from 30
HTTP connections 34, 52
HTTP downloads 52
HTTP traffic 63
I
IETF (Internet Engineering Task Force) 14
iMovie 68
compressing/encoding DV footage 69
live presentations 59
Instant-On streaming 23
Internet, multimedia sent over 18
Internet Engineering Task Force (IETF) 14
IP addresses
binding to 30
source computer 31
IP Firewall service 62
IP packets 62
iTunes 23
L
lighting issues 60, 65
lighting kit 63, 65
live audio
requirements for 24
setup for streaming 17
live broadcasting 24
live chats 20–21
live delivery 16
live events 16
live streaming
audio 17
choosing environment for 59–60
concurrent viewers 60
example of 57–69
network setup 60
video 17
live video
archiving 68–69
requirements for 24
setup for streaming 17
shooting 68
live webcasts 57–69
logging, enabling 51
Index
logs
  access history 32
  playlists 51
  resetting 32
looping playlists 51

M
  “Maximum Connections” setting 29
  “Maximum Throughput” setting 29
Mb bone (multicast backbone) 19
media 41–51
  bandwidth considerations 24
  Instant-On streaming 16
  prerecorded 42, 43
  protected 37
  sent over Internet 18
  streamed. See streamed media
  viewing from client computer 26
media directories
  disabling authentication for 36
  multiple 30–31
  symbolic links within 30–31
media files
  authorized users of 37
  media types in 43
  not streaming properly 51
  URL for 26
  user access to 37
memory 61
microphone 63, 64
movie files 52
movie playlists 43
  See also playlists
movie properties 45
movies
  QuickTime. See QuickTime movies
MP3 broadcasts 35
  .mp3 extension 25
  MP3 files 25, 43, 52
  MP3 playlists
  See also playlists
  creating 45
  listening to 23
MP3 streaming 52
MPEG-1 files 51
MPEG-4 files 8, 23
MPEG-4 player 23
MPEG-4 playlists 45
MPEG-4 streaming 8
multicast 19
multithoming 25, 28, 30
multimedia 18

network cards 62
networks
  address translation 34
  bandwidth and 60
  capacity of 60
  preparing for live streaming 60

O
on-demand delivery 16

P
passwords
  broadcaster user account 35, 63
  changing for users 38
  MP3 broadcasts 35
  user accounts 38
  for viewing media 37
performance
  hinted movies 44
players
  MPEG-4 23
  QuickTime. See QuickTime Player
PlaylistBroadcaster process 51
playlists 42, 48–51
  access to 36
  broadcasting prerecorded media with 42
  creating 45
  described 42
  looping 51
  movie 43
  MP3. See MP3 playlists
  MPEG-4 45
  names 45, 49
  preparing prerecorded media for 43
  problems with 51
  server-side 9
  starting 46
  stopping 46
playlists log 51
  “Play Mode” setting 46
plug-in, QuickTime 18, 52
port 80, streaming over 34
ports
  Firewire 58
  used by QTSS/DSS 62
poster frame 44
prerecorded media 43
presentations, streaming 57–69
problems. See troubleshooting

Q
qtaccess file 36–37
qtgroups file 38
qtusers file 37
QuickTime Broadcaster
Index

described 9
live audio/video setup 17
live presentations 59
obtaining 23, 65
QTSS/DSS and 17
requirements for 24
setting up 23, 65–66
streaming presentations 58
video capture 24
website 23, 65
QuickTime client software 23
“QuickTime for the Web” 13
QuickTime Instructional website 13
QuickTime movies
See also movies
exporting as hinted movies 44
sample 25
QuickTime Player
described 9
viewing media from clients 26
viewing movies 25
viewing streamed media on 18
window title 45
QuickTime plug-in 18, 52
QuickTime Pro
described 9
included with “QuickTime for the Web” 13
QuickTime product suite 7
QuickTime Services website 13
QuickTime streaming
See streaming
QuickTime Streaming Server (QTSS)
See also streaming servers
described 9
multiple media directories 30–31
obtaining 7
QuickTime Broadcaster and
requirements for 61–62
setting up 24–26, 60–63
QuickTime Streaming Server product page 13

R
RAID storage systems 61
RAM 61
real-time streaming 16
Real-Time Streaming Protocol. See RTSP
Real-Time Transport Protocol. See RTP
relays
broadcasting using 48
described 20
setting up 31
support for 9
uses for 20
Request Incoming Stream setting 31
resolution 64
resources 13–14
RTP (Real-Time Transport Protocol) 15
RTP payload encoder 44
RTP streams 24
RTSP (Real-Time Streaming Protocol) 15
S
SDP files
playlists and 51
purpose of 63
Secure Sockets Layer. See SSL
security 33–34
access control 35–38
firewalls 34
networks with address translation 34
passwords. See passwords
streaming on port 80 34
user accounts 38
“Sequential Looping” mode 46
“Sequential” mode 46
server administration guides 11
server administrators 36
servers
Apache 7
busy 29, 53
connection dropped 53
not running 53
Xserve 58
server-side playlists 9
Session Description Protocol files. See SDP files
skip-protection technology 8, 16
streamed media
controlling access to 35–38
errors during 52–53
relaying 20
viewing from client computer 26
streaming
codecs 42
from home directory 30
Instant-On 8, 23
instant-on 16
live. See live streaming
MP3 52
MPEG-4 8
over port 80 34
overview 15–17
process for 18
real-time 16
streaming files 61
streaming MP3 playlists 23
streaming presentations 57–69
Streaming Proxy settings 51
streaming servers
See also Darwin Streaming Server; QuickTime Streaming Server; servers
considerations 61–63
overview 15
requirements for 61–62
restricting access to 63
setting up 23–26, 60–63
testing setup 25
streaming service providers 13
Streaming Transport settings 51

T
T1 lines 60
Thumbnail Image 44
titles 45
tracks, hint 42
tripod 63, 65
troubleshooting 51–53
See also errors
backup QTSS databases 53
media files 51, 52
playlists 51

U
UDP packets 34
unicast 19
URLs
media files 26
RTSP 26
unable to locate 52
user accounts
adding 38
broadcaster 35, 63
passwords 38
User Datagram Protocol. See UDP
user file 37, 38
user names
authorized users 37
users
access control 36–38
broadcast 35
changing password 38
deleting from user/group file 38
messages for 37
multiple media directories 30–31
unable to connect to broadcast 52, 53
viewing media 37

V
valid-user tag 37
video
capture 24
streaming 17
video files 61

W
Web Admin 7, 28
web browsers
QuickTime plug-in 18
viewing streamed media through 26
webcasting setup 57–69
web pages
playing streamed media over 18
webcast access from 66
web servers 7
websites
Darwin Streaming Server 14
Internet Engineering Task Force 14
QuickTime Broadcaster 23, 65
QuickTime Instructional site 13
QuickTime Services 13
QuickTime Streaming Server 13
"Weighted Random" mode 47
WinAmp 23
Windows-based systems 18
wireless connections 59

X
XLR plugs 64
Xserve server 58